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Введение 
Программа Nuhertz Filter предназначена для синтеза и анализа фильтров в широком 

диапазоне от радиочастот до СВЧ. В этой программе можно синтезировать фильтры нижних 
частот, фильтры верхних частот, полосно-пропускающие фильтры, полосно-заграждающие 
фильтры и диплексеры. Синтезируемые фильтры могут иметь различные функции передачи: 
Гаусса, Бесселя, Баттерворда, Чебышева I и II рода и др. Фильтры могут быть реализованы 
на сосредоточенных элементах и на отрезках линий передачи. Поддерживаются линии 
RGLC, микрополосковые и симметричные линии. 

Программа Nuhertz Filter полностью интегрирована в сре-
ду проектирования Design Environment компании AWR. Если 
Nuhertz Filter инсталлирована, она появляется как подгруппа Nu-
hertz Filter Wizard (рис. 1) в группе мастеров Wizards в левом ок-
не просмотра проекта Microwave Office. Для синтезированного 
фильтра программа Nuhertz Filter автоматически создаёт в Mi-
crowave Office соответствующую схему и набор графиков для 
дальнейшего уточнения параметров элементов фильтра. Перейти 

из программы Nuhertz Filter в Microwave Office можно на любом этапе синтеза и анализа 
фильтра. Это можно сделать сразу же после ввода исходных данных для синтеза. При этом 
синтезированная схема фильтра немедленно передаётся в Microwave Office для дальнейшего 
моделирования. Или можно выполнить анализ в Nuhertz Filter, просмотреть полученные схе-
му и характеристики, причём можно быстро просмотреть несколько вариантов схемы фильт-
ра, выбрать наиболее подходящий и затем полученные результаты передать в Microwave Of-
fice для окончательной доработки схемы и топологии фильтра. 

Рис. 1 

Подход к синтезу фильтров СВЧ на отрезках линий передачи может быть различным. 
Например, можно сначала синтезировать фильтр на сосредоточенных элементах и затем за-
менить ёмкости и индуктивности эквивалентными отрезками линий (разомкнутыми или ко-
роткозамкнутыми шлейфами). Такой метод синтеза иногда даёт хорошие результаты, однако 
часто получаются нереализуемые элементы топологии. Или можно синтезировать фильтр 
непосредственно на отрезках линий. 

Чтобы запустить программу Nuhertz Filter, нужно раскрыть группу Wizards и дважды 
щёлкнуть левой кнопкой мышки по Nuhertz Filter Wizard. 

В данном пособии рассматривается синтез микрополосковых фильтров. Но аналогич-
но можно синтезировать фильтры и на других, доступных в программе, линиях. 

В приводимых примерах использовались Nuhertz Filter версии 4.0 и Microwave Office 
версии 7.5.1. 

 
Е.Е. Дмитриев 
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1. Интерфейс программы Nuhertz Filter 
 
После запуска программы открывается окно Filter Synthesis (рис.1.1). В верхней час-

ти этого окна находится строка меню. Ниже расположена строка кнопок, открывающих со-
ответствующие вкладки этого окна, 
на которых вводятся исходные дан-
ные для синтеза фильтра. Вид каж-
дой вкладки зависит от выбранного 
типа фильтра и выбранных устано-
вок для синтеза. Выполнение неко-
торых основных операций рассмот-
рим на примере синтеза фильтра с 
боковыми электромагнитными свя-
зями. 

На вкладке Topology (рис. 
1.1) вводятся: 

1. В поле Implementation (Реа-
лизация) указывается, на чём 
будет реализован фильтр. Ес-
ли выбрана одна из линий пе-
редачи, справа от этого поля 
появляется строка переключа-
телей, в которой указывается 
используемая система единиц 
измерения длины. Рис. 1.1 

2. В поле Shape (Вид) вводится вид характеристики, а в поле Type вводится тип фильт-
ра. 

3. В области Termination (Согласование) можно указать тип источника и нагрузки. По 
умолчанию это резистивные сопротивления в Омах. 

На вкладке Setting (Установ-
ки, рис. 1.2) вводятся: 
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1. Порядок фильтра (Order). 
2. В поле Pass Band Def опреде-
ляется способ ввода полосы 
пропускания. Для полосовых 
фильтров можно указать цен-
тральную частоту (Center 
Freq) или граничные частоты 
(Corner Freqs). В зависимости 
от этого выбора несколько из-
меняется содержание окна. Ес-
ли выбрано Center Freq, в сле-
дующих полях вводятся цен-
тральная частота (Center Freq) 
и ширина (Pass Band With) по-
лосы пропускания. Справа от 
этих полей указываются едини-
цы измерения для частоты. По 
умолчанию они такие же, как и 

в Microwave Office. Во втором случае вводятся нижняя и верхняя частоты полосы про-
пускания. 

Рис. 1.2 



3. Если отмечено Standard Pass Band Attenuation, полоса пропускания отсчитывается 
по уровню 3 дБ. Если эту отметку убрать, то в поле Pass Band Attenuation (dB) можно 
ввести уровень, по которому отсчитывать полосу пропускания. 

4. В поле Conductor Thickness вводится толщина проводника, а в поле Dielectric Height 
вводится толщина диэлектрика. Справа от этих полей указывается единица измерения 
для этих величин. 

5. В поле Cond. Resistivity Norm. To Copper вводится сопротивление проводника, нор-
мированное относительно меди. 

6. В поле Dielectric Loss Tangent вводится тангенс угла диэлектрических потерь. 
На вкладке Defaults (По умолчанию, рис. 1.3) вводятся дополнительные установки, 

которые будут действовать по умолчанию: 
1. В поля Source Resistance и Load 

Resistance вводятся сопротивления 
источника и нагрузки соответст-
венно. 
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2. В поле Dielectric Constant (Er) 
вводится значение диэлектриче-
ской проницаемости. 

3. В поле Frequency Where Aliasing 
Begins вводится частота, где начи-
нается неоднозначность. Эту часто-
ту рекомендуется устанавливать по 
возможности дальше от централь-
ной частоты. 

4. В поле Zeros Sequencing (Упоря-
дочение нуля) определяется, где 
должна быть нулевая частота, слева 
или справа. 

5. Если отмечено Coupled Resonator 
Filter (Связанный резонатор 

фильтра), то в поле Coupled Res Filter Type можно выбрать тип связи, щёлкнув по 
кнопке в правом конце этого поля. Т.е. здесь можно выбрать различные типы фильтров 
на связанных резонаторах (на разомкнутых или короткозамкнутых отрезках связанных 
линий, встречноштыревые или шпилечные и с различной связью с входными и выход-
ными линиями). 

Рис. 1.3 

6. По умолчанию сопротивление 
центрального резонатора уста-
навливается равным 75 Ом. 
Если отметить Coupled Reso-
nator Internal Impedance, то в 
поле Center Resonator Imped-
ance можно ввести другое зна-
чение этого сопротивления. 
На вкладке Schematic (рис. 

1.4) вводятся установки, которые 
определяют, как реализуемая схема 
будет передана в Microwave Office: 

1. В поле Schematic Name вво-
дится имя схемы. 

2. Если в области Schematic 
Generation (Генерация схемы) 
отметить Append (Добавить), 
то если в проекте Microwave 
Office уже есть схема с таким Рис. 1.4 



же именем, например Fil2, то будет добавлена новая схема с именем Fil21. Если отме-
тить Overwrite (Переписать), то, имеющаяся в Microwave Office схема будет заменена 
новой схемой с прежним именем. 

3. Если отмечено Include Optimization Goals, то в Microwave Office будут переданы це-
ли оптимизации. 

4. Если отмечено Show Layout, то в Microwave Office будет создана и показана тополо-
гия фильтра. 

5. Если отмечено Generate Graphs (Создать графики), то в окне появится дополнитель-
ная область Graph Information, в которой можно указать, какие графики должны быть 
созданы. Выбрав тип графика в поле Graph Configuration, можно указать измеряемые 
величины, которые должны отображаться на выбранном типе графика. 
На вкладке Summary (Резюме) отображается информация о моделируемом фильтре. 

Если теперь выбрать в меню Integration>Send To MWO, то схема с графиками и то-
пологией будет передана в Microwave Office для дальнейшего моделирования. В нижней час-
ти каждой вкладки имеется поле Issues (Результат), в котором отображается результат пере-
дачи схемы в Microwave Office или ошибки при передаче схемы, если передача по каким-то 
причинам не выполнена. На вкладке Summary отображаются все введённые установки для 
фильтра. На рис. 1.5 показано, как будут выглядеть в Microwave Office переданные из Nu-
hertz Filter схема, графики и топология, если установки в Nuhertz Filter сделаны, как показано 
на рисунках 1.1 – 1.4. Обратите внимание, что схема передана с добавленными переменны-
ми, назначенными для настройки, но для оптимизации схема не подготовлена, т.к. передача 
оптимизации не устанавливалась. Частоты для анализа переданы только для схемы фильтра. 
Их можно просмотреть, если щёлкнуть правой кнопкой мышки по имени схемы Fil в левом 
окне просмотра проекта и выбрать Options. Дважды щёлкнув левой кнопкой мышки по Pro-
ject Options, можно убедиться, что в проект никаких частот не добавлено. Глобальные еди-
ницы в Microwave Office должны быть установлены такие же, как и в Nuhertz Filter. 

Также обратите внимание, что Nuhertz Filter установила для скачков сопротивлений 
Х-модели MSTEPX$ и значение ErNom для элемента MSUB (подложки) равной 10.2. Это 

Рис. 1.5
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ближайшее значение ErNom, для которого в Microwave Office имеется заполненная Х-
модель. 

Если планируется не передавать схему в Microwave Office на этом этапе, а продол-
жить моделирование в Nuhertz Filter, в меню нужно выбрать Integration>Nuhertz Interface. 
Откроется основная панель управления Nuhertz Filter (рис. 1.6). На этой панели установлены 
все исходные данные для синтеза фильтра, которые были определены ранее в окне Filter 
Synthesis. Здесь можно изменить все введённые данные. Более того, если предполагалось 
продолжить синтез и анализ в Nuhertz Filter, в окне Filter Synthesis можно было и не вводить 
никаких данных, а сразу выбрать в меню Integration>Nuhertz Interface и все необходимые 
данные ввести в основной панели управления. 

Вверху основной панели управления расположена строка меню. Выбор в меню 
File>Save As позволяет сохранить новый проект в файле, выбор File>Save сохраняет сущест-
вующий проект. Выбор File>Open открывает проект, ранее сохранённый в файле. Файлы 
Nuhertz Filter сохраняются с расширением ftr. 

Если выбрать в меню Data, область Filter Attributes заменяется областью User Time 
Analysis Data (рис. 1.7). В этом окне можно загрузить пользовательские данные из файла, 
щёлкнув мышкой по Read Data. Повторный выбор в меню Data или щелчок мышкой по 
кнопке Close возвращает прежний вид панели управления. 

Если в области Line Parameters щёлкнуть мышкой по кнопке Real Parameters в пра-
вом нижнем углу панели управления, область Line Parameters заменяется областью Real 
Parameters, в которой можно ввести значения для последовательных и параллельных емко-
стных и индуктивных сопротивлений. Щелчок по кнопке Main Parameters возвращает преж-
нюю область Line Parameters. 

Рис. 1.6

Рис. 1.7 
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Чтобы просмотреть созданную схему фильтра, щёлкните мышкой по кнопке Circuits 
в правой нижней части панели управления. Откроется окно схемы (рис. 1.8), в котором ото-
бражается схема и значения параметров всех элементов схемы. Если отметить Fit (Подог-
нать) в правом верхнем углу, отображение схемы будет “подгоняться” под размер окна. 

В левом углу схемы находятся кнопки меню. Щёлкнув по кнопке меню, можно вы-
полнить команду, указанную на кнопке: 

Рис. 1.8

1. Print – Печать схемы. 
2. Copy – Копировать схему в буфер обмена. 

3. Annote – Комментировать, можно вве-
сти две строки пояснений к схеме. 

 7

4. NetList – Описание цепи. Создаёт Net-
List для схемы, которое можно сохранить 
в файле с расширением ckt. 

5. Freq – Открывает окно графиков коэф-
фициента передачи, фазы и группового 
времени задержки (рис. 1.9). В правой 
верхней части окна графиков имеется ряд 
переключателей, отмечая которые или 
снимая отметку, можно добавлять или 
убирать соответствующие графики. В ле-
вой верхней части этого окна имеется ряд 
кнопок меню. Если щёлкнуть мышкой по 

Limits, можно изменять параметры графика. Нажатие левой кнопки мышки в окне гра-
фика создаёт на графике маркер, который можно перемещать по графику, двигая мыш-
кой с нажатой левой кнопкой. Щелчок правой кнопкой мышки создаёт на графике по-
стоянный маркер. Щелчок правой кнопкой мышки по постоянному маркеру удаляет 
этот маркер. Щелчок мышкой по Text отображает результаты анализа в табличной 
форме, повторный щелчок убирает таблицу. Щелчок мышкой по Freeze закрепляет 
графики. 

Рис. 1.9

6. Zin – Открывает окно графика входного сопротивления (модуль и фазу). 
7. Zout – Открывает окно графика выходного сопротивления (модуль и фазу). 
8. Time – Открывает окно графика временного затухания сигнала. 
9. Ref in – Открывает окно графика коэффициента отражения по входу фильтра (модуль 
и фазу). 

10. Ref out – Открывает окно графика коэффициента отражения по выходу фильтра (мо-
дуль и фазу). 

11. MWO – Передать схему в Microwave Office. Если щёлкнуть мышкой по этой кнопке, 
открывается окно (рис. 1.10), в котором можно определить опции передачи схемы (т.е. 
нужно ли выполнить анализ сразу после передачи (Simulate After Export), какого типа 
графики передать, что отображать на графиках и др.). Если в правом верхнем углу окна 



отметить Do Not Export Frequency Limits, то частоты в Microwave Office передаваться 
не будут, и будут использоваться частоты, определённые в проекте Microwave Office. 

В правом верхнем углу схемы если отметить Other Info (Другая информация), то па-
раметры элементов в схеме будут отображены в емкостях и индуктивностях. Переключатель 
Coupled Resonators (Связанные резонаторы) на схеме отмечен, что соответствует сделан-
ным ранее установкам для синтеза фильтра. Если эту отметку убрать, схема будет изменена 
(рис.1.11). На этой схеме ширины проводников и зазоры помечены Invalid. Это означает, что 
топология не реализуема. Второй и предпоследний резонаторы выполнены на короткозамк-
нутых отрезках, в отличие от остальных резонаторов. Тем не менее, в Nuhertz Filter такая 
схема будет проанализирована и создан график. Эту схему можно передать в Microwave Of-
fice и там она будет отображена, но её анализ выполняться не будет. 

Кроме того, в правом верхнем углу схемы имеется область Coupled Resonator Pa-
rameters (Параметры связанных резонаторов). В этой области расположен ряд переключате-
лей, позволяющих просмотреть другие варианты реализации фильтра на связанных резона-
торах. Для некоторых вариантов новая схема создаётся сразу. Например, если отметить 
Comb Line (Гребенчатая линия), то будет создана схема гребенчатого фильтра (рис. 1.12). 

Рис. 1.10

Рис. 1.11

Рис. 1.12
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Переданная в Microwave Office схема будет выглядеть, как показано на рис. 1.13. 
Если отметить Hairpin 

(Шпилька), то в начале появля-
ется сообщение об ошибке с 
подсказкой, что нужно сделать 
(рис. 1.14). Здесь сообщается, 
что нельзя рассчитать фильтр, 
нужно выбрать опцию Tapped 
(Кондуктивная связь) или 
Pinned (Шпилечная связь). Если 

отметить Pinned. Будет создана 
схема, показанная на рис. 1.15. 
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Рис. 1.16 

Рис. 1.17 

 
 

П

Рис. 1.14 

Рис. 1.13 

ереданная в Microwave Office схема будет выглядеть, как показана на рис 1.16, а то-
пологи

 образом, 
област led R

e

ть 
п

 выбра

я на рис. 1.17. 

Таким
ь Coup esonator 

Paramet rs предоставляет 
удобную возможность 
просмотре несколько 
вариантов остроения 
фильтра и ть из них 
оптимальный вариант, не 
выходя их режима просмотра 

схемы. Напомним, что одновременно вы можете просматривать и графики для каждого вари-
анта.  

В правом верхнем углу основной панели управления Nuhertz Filter (рис. 1.6) имеется 
область Ideal Filter Response (Характеристика идеального фильтра). Щёлкая левой кнопкой 
мышки по кнопкам в этой области, можно просмотреть функцию передачи фильтра и неко-
торые графики, не открывая окно схемы. 

Параметры любого элемента схемы могут быть изменены. Для этого установите кур-
сор на элемент схемы (цвет этого элемента должен измениться на красный) и щёлкните ле-

Рис. 1.15



вой кнопкой мышки. Откроется окно редактирования элемента, вид которого зависит от типа 
выбранного элемента. В нашем случае связанных отрезков 
линий это окно будет иметь вид, показанный на рис. 1.18. 
В поле Enter Segment Length можно изменить длину свя-
занных отрезков. В поле Enter Segment Zo можно изме-
нить волновое сопротивление чётной моды и/или нечётной 
в зависимости от выбора в области Mode Select. В области 
Type Change (Тип изменения) отмечается тип изменения, 
которое вы хотите сделать. 

Если отметить Value (Значение), то изменение зна-
чения параметра производится в соответствующих едини-
цах измерения. В этом случае для изменения параметра 
просто введите новое значение в соответствующее поле 
ввода и нажмите Apply. Изменение немедленно отобража-
ется на схеме, а в окне рис. 1.18 появляется строка Def Val, 
в которой отображается установленное ранее значение по 
умолчанию, и кнопка Restore Default Value, щёлкнув по 
которой, можно вернуть прежнее значение. 

Если отметить Percent (Процент), окно отобража-
ется, как показано на рис. 1.19. Здесь нужно указать, для 
каких параметров нужно изменить значения, отметив со-
ответствующий квадратик Update (Обновить). В поле En-
ter Percent Change введите, сколько процентов от преж-
него значения нужно оставить. Нажмите Apply. 

Если отметить Random (Случайный), окно отобра-
жается, как показано на рис. 1.20. В этом случае значение 
параметра изменяется по случайному закону. В поле Enter 
% Maximum Tolerance введите максимальный допуск в 
процентах, из которого будет взята случайная выборка. В 
области Distribution отметьте закон распределения Uni-
form (Равномерный) или Gaussian (Гауссовый). Нажмите 
Apply. 

Чтобы внесённые изменения вступили в силу, на-
жмите OK. Изменённые значения параметров отобража-
ются синим цветом. При желании вы можете изменить 
цвета, выбрав Options>Colors в меню основной панели 
Nuhertz Filter рис. 1.6. 

Если в окне рис. 20 отмечено Random, можно вы-
полнить статистический анализ Монте Карло. Для выпол-
нения этого анализа в поле Enter No of Runs введите ко-
личество выполнений (т.е. число итераций для статистиче-
ского анализа). Если отметить Maintain Old Traces (Под-
держивать старые трассы), то на графике будут отобра-
жаться кривые для всех итераций (рис. 1.21). Если отмече-
но Update All Stubs and Segments (Обновить все шлейфы 
и сегменты), в окне откроется дополнительная область 
Parts Base (Базовые формы). В этой области можно ука-
зать, какие начальные значения брать для статистического 
анализа, начальные значения, ранее установленные по 
умолчанию, или значения, изменённые пользователем в 
одном из описанных ранее окон. После ввода этих данных, 
нажмите Apply. Вариант статистического анализа показан 
на рис. 1.21. 

 

Рис. 1.18 

Рис. 1.19 

 10Рис. 1.20 



 

При экспортировании схемы в Microwave Office в схему вводятся Х-модели для тех 
элементов схемы, для которых они имеются в Microwave Office. В Microwave Office имеется 
ряд Х-моделей, уже заполненных для некоторых значений диэлектрических проницаемостей 
часто применяемых материалов диэлектриков. В Nuhertz Filter встроена таблица этих значе-
ний и при экспортировании схемы Nuhertz Filter автоматически присваивает элементу значе-
ние ErNom, взятое из этой таблицы, ближайшее к заданному значению диэлектрической 
проницаемости Er. Поэтому выполнять заполнение Х-моделей не требуется. На точности вы-
числения это обычно сказывается незначительно. 

Рис. 1.21
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2. Фильтры нижних частот 
 
Требуется спроектировать фильтр с полосой пропускания до 8 ГГц. 

Для реализации выберем 
фильтр на отрезках микрополоско-
вой линии разной ширины на под-
ложке из поликора толщиной 0.5 мм. 
Предварительный синтез фильтра 
выполним в программе Nuhertz Filter 
с последующим уточнением схемы и 
топологии в Microwave Office. 

Загрузите Microwave Office и 
выберите в меню Options>Project 
Options. В открывшемся окне опций 
проекта на вкладке Global Units вве-
дите единицы измерения частоты 
GHz и отметьте Metric units (рис. 
2.1). Нажмите OK. Рис. 2.1 

В левом окне просмотра про-
екта на вкладке Project раскройте 
группу Wizards и дважды щёлкните 
по Nuhertz Filter Wizard. Откроется 
окно Filter Synthesis программы Nu-
hertz Filter. 

 
На вкладке Topology (рис. 2.2): 

1. В поле Implementation (Реали-
зация) введите Microstrip. 

2. В поле Shape (Вид) введите 
Chebyshev I. 

3. В поле Type введите Low Pass. 
 
На вкладке Settings (рис. 2.3): 

1. В поле Order (Порядок) введите 
5. 

2. В поле Pass Band Freq (Частота 
полосы пропускания) введите 8 
GHz. 

Рис. 2.2 
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3. Отметьте Standard Pass Band 
Attenuation. 

4. В поле Pass Band Ripple (dB) 
введите величину пульсаций в 
полосе пропускания 0.5. 

5. В поле Conductor Thickness 
(Толщина проводника) введите 
0.005 mm. 

6. В поле Dielectric Height (Тол-
щина диэлектрика) введите 0.5. 

7. В поле Dielectric Loss Tangent 
введите тангенс диэлектрических 
потерь 0.0001. 

 
Рис. 2.3



На вкладке Defaults (рис. 2.4): 
1. В полях Source Resistance (Со-
противление источника) и Load 
Resistance (Сопротивление на-
грузки) введите 50 Ohm. 

2. В поле Dielectric Constant (Er) 
введите диэлектрическую прони-
цаемость 10.43. 

3. В поле Frequency Where Alias-
ing Begins введите 18 GHz. 

4. В поле Zeros Sequencing (Упо-
рядочение нуля) введите Left 
(слева). 

5. В поле Source Element введите 
Voltage. 

6. В поле First Element введите 
Series (Последовательный), т.е. 
наш фильтр должен начинаться с 
высокоомной тонкой линии, яв-
ляющейся эквивалентной индук-
тивностью. 

 
На вкладке Schematic (рис. 2.5): 

1. 

Рис. 2.4 

В поле Schematic Name введите 

 Optimization 

те Generate Graphs 

To Generate 

 Measurement for 

imits отметь-

амечание. В области сообщений Issues в случае ошибочного ввода появляется пре-
дупреж

осле ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 
основн

 

 13

имя схемы FilN1. 
2. Отметьте Include

Goals (Включить цели оптимиза-
ции). 

3. Отметь
(Создать графики). 

4. В области Graphs 
отметьте Rectangular (Прямо-
угольный). 

5. В области
Rectangular отметьте Forward 
Transfer dB(S21). 

6. В области Graph L
те Sent To MWO, в поле Min 

Freq введите 0 GHz, в поле Max Freq введите 18 GHz. 
 
З
дение об ошибке. Показанное на рис. 2.5 сообщение (Вы пытаетесь ввести текст в чи-

словое поле) появляется, если клавиатура не переключена на английскую раскладку (вместо 
точки с цифровой клавиатуры вводится запятая). 

 
П
ое окно панели управления Nuhertz Filter (рис. 2.6). В строке меню этого окна выбери-

те File>Save As и сохраните синтезируемый фильтр в файле FilN. 
 
 

Рис. 2.5 
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В правой нижней части окна щёлкните мышкой по кнопке Circuits. Откроется окно с 
синтез

е

жнем 
углу о

новременно отметить и 1 st 
Ser, и st Shu. В этом случае будут 

е мышкой по кноп-
ке Freq в левой верхней части окна 

яет предъявляе-

Рис. 2.6

ированной схемой фильтра 
(рис. 2.7). На этой схем  ширина про-
водника между шлейфами помечена 
Invalid, что говорит о том, что струк-
тура фильтра не реализуема (слиш-
ком мала ширина этого проводника). 

Закройте окно схемы. На па-
нели управления рис. 2.6 в области 

ine Parameters в правом ни
Рис. 2.7 

L
кна снимите “галочку” в 1 st 

Ser и отметьте 1 st Shu, чтобы схема 
начиналась не с последовательного 
элемента, а с параллельного шунта. 
Щёлкните мышкой по кнопке Cir-
cuits. Полученная схема показана на 
рис. 2.8. В этой схеме уже нет пре-
дупреждения о нереализуемых эле-
ментах. 

 
Замечание. В окне рис. 2.6 

можно од
1 Рис. 2.8 

открыты одновременно два окна со 
схемами для сравнения. 

 
Щёлкнит

схемы рис. 2.8. Установив курсор в 
открывшемся окне графика (рис. 
2.9), нажмите левую кнопку мышки. 
Перемещая мышку, установите поя-
вившейся маркер на частоту 8 GHz 
и щёлкните правой кнопкой мышки, 
чтобы закрепить маркер. Рассчи-
танная в Nuhertz Filter характери-
стика удовлетвор
мым требованиям. Рис. 2.9 
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м верхнем углу схемы. Откроется окно рис. 2.10. 

Для уточнения характеристики, передайте схему в Microwave Office. Для этого щёлк-
ните левой кнопкой мышки по окну схемы рис. 2.8 и затем щёлкните мышкой по кнопке 
MWO в левом верхнем углу схемы. Откроется окно рис. 2.10. 

В этом окне: В этом окне: 
Рис. 2.10

1. В поле Schematic Name введите имя схемы FilN1. 1. В поле Schematic Name введите имя схемы FilN1. 
2. Отметьте Simulate After Export (Выполнить анализ после экспорта) и Include Opti-

mization Goals (Включить цели оптимизации). 
2. Отметьте Simulate After Export (Выполнить анализ после экспорта) и Include Opti-

mization Goals (Включить цели оптимизации). 
3. Отметьте тип графика Rectangular и снимите отметки у остальных типов графика 

Smith Chart, Tabular и Polar. 
3. Отметьте тип графика Rectangular и снимите отметки у остальных типов графика 

Smith Chart, Tabular и Polar. 
4. В области Rectangular Measurements (Измеряемые величины прямоугольного графи-
ка) отметьте Forward S21 и снимите отметки у всех остальных измеряемых величин, 
отметьте dB и щёлкните мышкой по Append to MWO. 

4. В области Rectangular Measurements (Измеряемые величины прямоугольного графи-
ка) отметьте Forward S21 и снимите отметки у всех остальных измеряемых величин, 
отметьте dB и щёлкните мышкой по Append to MWO. 

5. Щёлкните левой кнопкой мышки по окну Microwave Office, чтобы сделать его актив-
ным. Схема, переданная в Microwave Office показана на рис. 2.11, а график, рассчитан-
ный в Microwave Office – на рис. 2.12. 

5. Щёлкните левой кнопкой мышки по окну Microwave Office, чтобы сделать его актив-
ным. Схема, переданная в Microwave Office показана на рис. 2.11, а график, рассчитан-
ный в Microwave Office – на рис. 2.12. 

В созданной схеме используются X-модели, в элементе MSUB (подложка) параметр 
ErNom получил значение 10.2. Это ближайшее значение диэлектрической проницаемости, 
для которого в Microwave Office имеется заполненная Х-модель. 

В созданной схеме используются X-модели, в элементе MSUB (подложка) параметр 
ErNom получил значение 10.2. Это ближайшее значение диэлектрической проницаемости, 
для которого в Microwave Office имеется заполненная Х-модель. 

В схему добавлены переменные, которые уже назначены для настройки, и определены 
цели для оптимизации. 

В схему добавлены переменные, которые уже назначены для настройки, и определены 
цели для оптимизации. 

Рис. 2.11 Рис. 2.12 



Характеристика, рассчитанная в Microwave Office, не удовлетворяет поставленным 
требованиям. Попробуем выполнить 
оптимизацию. 
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1. Сделайте активным окно графи-
ка. 

2. Выберите в меню Simu-
late>Optimize. В методах опти-
мизации выберите Pointer – Ro-
bust Optimization, в поле Maxi-
mum Iterations введите 500 и на-
жмите Start. 
Характеристика после оптими-

зации показана на рис. 2.13. Как видно, 
оптимизация не удалась. Можно по-
пробовать другие методы оптимизации. 
Мы воспользуемся настройкой фильт-
ра. 

1. Щёлкните мышкой по окну схе-
мы в основном окне проекта или дважды щёлкните по имени схемы FilN1 в левом окне 
просмотра проекта, чтобы сделать это окно активным. Переменная W2 на схеме имеет 
ширину меньше 0.1 мм. Установите курсор на эту переменную и дважды щёлкните 
мышкой. В открывшемся поле редактирования введите 0.1, ограничив ширину провод-

ника этим значением. Нажмите 
клавишу Enter или щёлкните 
мышкой вне этого поля. 

Рис. 2.13 

2. Щёлкните левой кнопкой мышки 
по значку Tune Tool на панели ин-
струментов, установите курсор на 
переменную W2 и щёлкните мыш-
кой, чтобы исключить её из на-
стройки, и затем щёлкните мыш-
кой на свободном месте окна схе-
мы. 

3. Сделайте активным окно графика, 
на панели инструментов щёлкните 
мышкой по значку Analyze, затем 
щёлкните по значку Tune. Откро-
ется блок настройки схемы (рис. 
2.14). 

4. Двигая движки на блоке настройки, добейтесь удовлетворительной характеристики, 
причём полученные значения переменных округлите до пяти сотых, считая, что размер 
сетки в топологии предварительно выберем 0.5 мм. Полученная в результате настройки 
характеристика показана на рис. 2.14. Закройте блок настройки. 

Рис. 2.14 

5. Сделайте активным окно схемы, отмените настройку для всех переменных, щёлкнув 
по значку Tune Tool на панели инструментов. Удалите цель оптимизации, щёлкнув по 
её имени в левом окне проекта и выбрав Delete Goal. 

 
Теперь вернёмся в интерфейс программы Nuhertz Filter. Для этого щёлкните по имени 

этой программы на панели задач Windows. Если при работе с проектом был перерыв и про-
грамма Nuhertz Filter не загружена, раскройте группу Wizards в левом окне просмотра про-
екта Microwave Office и дважды щёлкните по Nuhertz Filter Wizard. В открывшемся окне 
выберите в меню Integration>Nuhertz Interface. В открывшемся окне основной панели 
управления Nuhertz Filter выберите в меню File>Open и откройте сохранённый файл синте-
зируемого фильтра. 
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Щёлкните по окну панели управления Nuhertz Fi

ем углу окна схемы 
щёлкните

Замечание. Схемы и графики для 
предыд

ёлкните мышкой по окну схемы 
и затем

 щёлкните по перемен-

lter (рис. 2.6), чтобы сделать его ак-
тивным. В этом окне отметьте 1 st Shu и 
отметьте Shunt Cap Segs. Нажмите Cir-
cuits. Откроется окно с новым вариантом 
схемы рис. 2.15. 

В левом верхн
 мышкой по кнопке Freq, откро-

ется график синтезированного фильтра 
рис. 2.16. Полученная характеристика не 
удовлетворяет поставленным требовани-
ям. Схему можно подстроить в Nuhertz 
Filter, но в Microwave Office это сделать 
удобнее. 
 

Рис. 2.15 

ущего варианта структуры фильт-
ра и для этого можно просмотреть в Nu-
hertz Filter и уже здесь выбрать подходя-
щий вариант. Мы второй вариант про-
смотрим в Microwave Offise. 

 
Щ
 щёлкните по кнопке MWO в ле-

вом верхнем углу окна схемы. В открыв-
шемся окне в поле Schematic Name введите имя схемы FilN2. Все остальные установки сде-

лайте такими же, как и в предыдущем окне 
(рис. 2.10). Щёлкните мышкой по кнопке 
Append to MWO. Переданная в Microwave 
Office схема выглядит, как показано на рис. 
2.17, а график – на рис. 2.18. Теперь в про-
екте имеется две схемы и два графика, от-
дельно для каждой схемы. Одновременно в 
проект переданы переменные, подготов-
ленные для настройки, и цель оптимизации 
для второй схемы. Можно попробовать 
выполнит оптимизацию. Мы будем ис-
пользовать инструмент настройки схемы. 

1. Сделайте активным окно схемы 
FilN2. Дважды

Рис. 2.16

Рис. 2.17

ной W2 и измените её значение на 
0.1. Щёлкните мышкой по значку Рис. 2.18
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щёлкните 

ст-

есь прием-

 
тдельных 

ilN1 в группе Graphs в левом 

ilN1:DB(|S(2,1)|) 

крывшемся окне 

hs в левом окне про-

 про-

В 

Tune Tool на панели инструментов, установите курсор на переменную W2 и щёлкните 
мышкой, чтобы исключить эту переменную из настройки. 

2. Сделайте активным окно 
графика FilN2 и 
мышкой по значку Analyze 
на панели инструментов. 

3. Щёлкните мышкой по 
значку Tune на панели ин
рументов, чтобы открыть 
блок настройки. 

4. Двигая движки на блоке на-
стройки, добейт
лемой характеристики при 
значениях переменных, 
кратных пяти сотым. 
Полученная характеристи-

ка показана на рис. 2.19. 
В результате в проекте мы 

имеем две схемы и два о
графика. Для удобства сравнения объединим эти графики и введём частоты проекта. 

1. Щёлкните правой кнопкой мышки по имени график F

Рис. 2.19 

окне проекта, выберите Rename Graph и переименуйте график в LdB. 
2. Щёлкните правой кнопкой мышки по имени измеряемой величины F
под графиком LdB в левом окне проекта и выберите Properties. В открывшемся окне в 

поле Data Source Name введите 
All Sources и нажмите OK. 

3. Щёлкните правой кнопкой 
мышки по графику и выберите 
Properties. В от
свойств графика на вкладке Axes 
для оси х снимите “галочку” в 
Auto divs и в поле Step введите 
1. Для оси Left 1 снимите “га-
лочки” в Auto limits и Auto divs, 
в поле Min введите -80, в поле 
Max введите 0, в поле Step вве-
дите 5, нажмите Apply и OK 
(рис. 2.20). 

4. Щёлкните правой кнопкой 
мышки по имени график FilN2 в 
группе GrapРис. 2.20 
екта и выберите Delete Graph, 
чтобы удалит этот график. 

5. Дважды щёлкните по Project 
Options в левом окне проекта. В 
открывшемся окне свойств
екта отметьте Replace (Заменить), 
в поле Start(GHz) введите 0, в 
поле Stop(GHz) введите 18, в по-
ле Step(GHz) введите 1, нажмите 
Apply и OK (рис. 2.21). 

6. Щёлкните правой кнопкой по 
имени схемы FilN1 в левом окне 
проекта и выберите Options. 

Рис. 2.21 
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в. 

 видно, что 
схема F

1. 
 

ени в левом 
окне п

кнопку мышки и переместите порт на свободное 

ments. 

 окна найдите элемент MLIN, переместите его в окно схемы и подключи-

ент MLIN должен быть выделен). Подключите скопированный 

т к выходу схемы. Полученная схема 

йте активным окно графика. 

не изменилась. 

открывшемся окне опций отметьте Use project defaults и нажмите OK. Аналогично на-
значьте частоты проекта для схемы FilN2. 

7. Щёлкните по значку Analyze на панели инструменто
Полученный график показан на рис. 

2.22. Из сравнения характеристик
ilN1 имеет более крутой скат и её мож-

но выбрать для реализации. Напомним, что 
этот вывод можно было сделать и в Nuhertz 
Filter. Мы для уточнения топологии и сравне-
ния результатов электромагнитного моделиро-
вания возьмём обе схемы. 

Вначале выполним электромагнитное 
моделирование для схемы FilN

Сделайте активным окно схемы FilN1, 
дважды щёлкнув мышкой по её им

росмотра проекта. Добавим на входе и 
выходе схемы 50-омные отрезки линии. 

1. Нажмите клавишу Ctrl, установите кур-
сор на входной порт, нажмите леву

Рис. 2.22 
ю 

место в окне схемы, прервав его связь со схемой. 
2. Откройте окно просмотра элементов в левом окне проекта, щёлкнув мышкой по кноп-
ке Ele

3. Раскройте группу Microstrip и отметьте подгруппу Lines. В списке элементов в левой 
нижней части
те к плечу 1 первого элемента MTEEX$. Дважды щёлкните левой кнопкой мышки по 
элементу MLIN. В открывшемся окне свойств элемента введите W=0.45 mm и L=3 
mm, нажмите OK. 

4. Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste на панели 
инструментов (элем
элемент к плечу 2 последнего элемента MTEEX$. 

5. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите 
порт ко входу схемы. Аналогично подключите пор
показана на рис. 2.23. 

6. Откройте окно просмотра проекта, щёлкнув мышкой по кнопке Project в левой ниж-
ней части окна, и сдела

Рис. 2.23
7. Щёлкните левой кнопкой по значку Analyze на панели инструментов. Характеристика 
после добавления отрезков линии на входе и выходе 
Теперь создадим топологию схемы. 
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N1, дважды щёлкнув левой кнопкой мышки по 

 View 

 активным окно схемы Fil1. Сделайте
имени этой схемы в группе Circuit Schematics в левом окне проекта. 

2. Щёлкните левой кнопкой мышки по значку New Schematic Layout
 на панели инструментов. 

3. По умолчанию размер сетки топологии равен 0.1 мм. Уменьшим этот раз-

к показано на рис. 
 

я 

ерите в 

мер до 0.05. Для этого щёлкните левой кнопкой мышки по полю ввода Grid 
Spacing (Интервал сетки) на панели инструментов и введите в это поле 
0.5х, щёлкнув по кнопке в правом конце поля (рис. 2.24). 

4. Созданная топология может иметь неправильный вид, ка
Рис. 2.24 

(в таком случае 
правильные 
соединения 

топологических 
элементов по-

казываютс

2.25

красными линиями). 
5. Чтобы упорядочить топологию, выделите все элементы топологии. Для этого устано-
вите курсор мышки левее и выше топологии, нажмите левую кнопку мышки и, не от-
пуская кнопки, переместите курсор правее и ниже топологии так, чтобы вся топология 
была в образовавшемся прямоугольнике, отпустите кнопку мышки. Или выб

Рис. 2.25 

меню Edit>Select All. 
6. Щёлкните левой кнопкой 
мышки по значку Snap To-
gether (Привязать вместе)  на 
панели инструментов или вы-
берите в меню Edit>Snap To-
g

о 

ether. 
Созданная топология показа-

на на рис. 2.26. Щёлкните левой кнопкой п значку Measure (Измерение)  не панели инст-
рументов. Поместите курсор с отображением линейки на правый верхний угол топологии, 
нажмите левую кнопку мышки и, не отпуская кнопки, переместите курсор на левый верхний 
угол топологии (рис. 2.26). Измеренная длина топологии равна 12.05 мм. Измеренная анало-
гично ширина топологии равна 1.95 мм. Эти данные нужны для создания электромагнитной 
структур

Рис. 2.26 

ы. Сначала определим корпус. 
1. Щёлкните мышкой по значку New EM Structure  или выберите в меню Pro-

ject>Add EM Structure> New EM Structure. В отрывшемся окне введите имя структу-
ры FN1, отметьте симулятор AWR EMSight Simulator и нажмите Create (Создать). На 
рабочем поле откроется окно электромагнитной структуры и в левом окне проекта в 

группе EM Structures появится имя созданной 
структуры, как подгруппа. 

2. Щёлкните левой кнопкой мышки по значку Sub-
strate Information  на панели инструментов 
или дважды щёлкните по Enclosure под именем 
структуры в левом окне проекта. Откроется окно 
свойств электромагнитной структуры. 

3. На вкладке Enclosure (рис. 2.27) введите значе-
ния X_Dim=12.05 mm (это длина корпуса, которая должна точно совпадать с длиной 
топологии), Y_Dim=4 mm (ширина корпуса), Grid_X=0.05 mm и Grid_Y=0.05 mm 
(размер ячеек сетки по осям X и Y). 

Рис. 2.27 

4. На вкладке Material Defs (Определения материала) в разделе Dielectric Definitions 
(Определения диэлектрика) введите Er=10.23 и TanD=0.0001. В остальных разделах 
оставьте значения по умолчанию. 

5. На вкладке Dielectric Layer для слоя 1 введите 6, для слоя 2 введите 0.5. 



6. На вкладке Materials отметьте 1/2oz Cu. 
7. Нажмите OK. 

Теперь вставим топологию в корпус. 
1. Сделайте активным окно топологии схемы, щёлкнув по нему мышкой. Если этого ок-
на не видно (закрыто другими окнами), упорядочите расположение окон, например, 
выбрав в меню Window>Tile Horizontal. 

2. Выделите всю топологию схемы и щёлкните по значку Copy на панели инструментов. 
3. Сделайте активным окно электромагнитной структуры, щёлкните по значку Paste на 
панели инструментов и вставьте топологию в корпус так, чтобы края входного и вы-
ходного проводников точно совпадали с краями корпуса (рис. 2.28). 

4. Щёлкните правой кнопкой мышки по любому элементу топологии при выделенной 
всей топологии и выберите Shape Properties. В открывшемся окне в поле Material вве-
дите 1/2oz Cu, щёлкнув левой кнопкой мышки по кнопке в правом конце этого поля, 
нажмите OK. 

Рис. 2.28

5. Щёлкните левой кнопкой мышки по входному проводнику, чтобы выделить его. 
Щёлкните мышкой по значку Edge Port  на панели инструментов или выберите в 
меню Draw>Add Edge Port, поместите курсор на левый край входного проводника так, 
чтобы на этом краю появился небольшой прямоугольник, и щёлкните мышкой, чтобы 
закрепить порт. Щёлкните по порту левой кнопкой мышки, чтобы выделить его, помес-
тите курсор на правый край прямоугольника порта так, чтобы курсор отображался в 
виде двойной стрелки. Нажмите левую кнопку мышки и, не отпуская кнопки мышки, 
сместите референсную плоскость порта на 1 мм вправо, отпустите кнопку. 

6. Аналогично установите порт на 
выходе структуры. Созданная то-
пология показана на рис. 2.28. 
Сделайте окно графика активным 

и щёлкните по значку Analyze. График 
показан на рис. 2.29. Характеристика, 
полученная в электромагнитном модели-
ровании, довольно хорошо совпадает с 
характеристикой, полученной в линей-
ном моделировании. 

Теперь выполним электромагнит-
ное моделирование для второй схемы. 

Сделайте активным окно схемы 
FilN2. Рис. 2.29 
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Добавьте 50-омные отрезки линий на входе и выходе схемы, как описано выше для 
первой схемы. Схема будет выглядеть, как показано на рис. 2.30. 

Щёлкните левой кнопкой мышки по значку New Schematic Layout View на панели 
инструментов. В открывшемся окне 
топологии выделите всю топологию 
и щёлкните по значку Snap Together 
на панели инструментов. Введите 
0.5х в поле Grid Spacing на панели 
инструментов. Созданная топология 
схемы показана на рис. 2.31. Длина 
топологии 12 мм, ширина – 3.6 мм. 

Создайте электромагнитную 
структуру с именем FN2. Длину кор-
пуса введите 12 мм, ширину – 6 мм. 
Остальные параметры введите такие 
же, как и для структуры FN1. Для 
проводников назначьте материал 
1/2oz Cu. Топология должна выгля-
деть, как показано на рис. 2.32. Сде-
лайте активным окно графика и 

щёлкните по значку Analyze на панели инструментов. График показан на рис. 2.33. Характе-
ристика электромагнитной структуры FN2 сдвинута вниз по частоте по сравнению с харак-
теристикой схемы FilN2. Чтобы характеристику сдвинуть вверх по частоте, нужно умень-

шить ширину емкостных проводников. 
Дважды щёлкните по первому емкостному 

проводнику, установите курсор на ромбик 
посередине верхней стороны проводника, 
нажмите левую кнопку мышки и сдвиньте 

эту сторону на 0.2 мм вниз (рис. 2.34). Аналогично сдвиньте нижнюю сторону этого провод-
ника на 0.2 мм вверх. Таким же образом уменьшите ширину второго и третьего емкостных 

Рис. 2.30 

Рис. 2.31

Рис. 2.32 

Рис. 2.34

Рис. 2.33 
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проводников. Щёлкните по значку 
Analyze на панели инструментов. 
График показан на рис. 2.35. 
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Рис. 2.35 

 



3. Фильтры верхних частот 
 
Требуется спроектировать фильтр с полосой пропускания от 8 ГГц. 
Загрузите Microwave Office. Выберите в меню Options>Project Options. На вкладке 

Global Units открывшегося окна опций проекта введите единицы измерения для частот GHz, 
для ёмкости pF, отметьте Metric units и для единиц измерения длины ведите mm. Нажмите 
OK. 

В левом окне просмотра проекта раскройте группу Wizards и дважды щёлкните мыш-
кой по Nuhertz Filter Wizard. 

В открывшемся окне Filter Synthesis на вкладке Topology: 
1. В поле Implementation введите Microstrip. 
2. В поле Shape введите Chebyshev I. 
3. В поле Type введите High Pass. 

На вкладке Settings: 
1. В поле Order введите 7. 
2. В поле Pass Band Freq введите 8 GHz. 
3. Отметьте Standard Pass Band Attenuation. 
4. В поле Pass Band Ripple (dB) введите величину пульсаций в полосе пропускания 0.5. 
5. В поле Conductor Thickness (Толщина проводника) введите 0.005 mm. 
6. В поле Dielectric Loss Tangent введите тангенс диэлектрических потерь 0.0001. 

На вкладке Defaults: 
1. В полях Source Resistance и Load Resistance введите 50 Ohm. 
2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемость 10.43. 
3. В поле Frequency Where Aliasing Begins введите 20 GHz. 
4. Значение остальных полей можно оставить по умолчанию. 

На вкладке Schematic: 
1. В поле Schematic Name введите имя схемы Fil_High. 
2. Отметьте Include Optimization Goals. 
3. Отметьте Generate Graphs. 
4. В области Graphs To Generate отметьте Rectangular. 
5. В области Measurement for Rectangular отметьте Forward Transfer dB(S21). 
6. В области Graph Limits отметьте Sent To MWO, в поле Min Freq введите 0 GHz, в 
поле Max Freq введите 18 GHz. 
После ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 

основное окно панели управления Nuhertz Filter (рис. 3.1). В строке меню этого окна выбери-
те File>Save As и сохраните синтезируемый фильтр в файле Fil-High. 

Рис. 3.1 
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Изменяя установки в области Line Parameters в пра-
вой нижней части этого окна, можно получить различные ва-
рианты структуры фильтра, многие из которых будут нереа-
лизуемые. Например, сделайте в этой области установки, как 
показано на рис. 3.2, и щёлкните мышкой по кнопке Circuits. 
Будет открыто два окна с синтезированными схемами (рис. 
3.3 и 3.4) на отрезках связанных линий с подключенными ко-
роткозамкнутыми шлейфами. 

На обеих схемах параметры связанных отрезков линий помечены Invalid, что говорит 
о нереализуемости этих схем. В Nuhertz Filter можно выполнить анализ этих схем, щёлкнув 
мышкой по кнопке Freq в левом верхнем углу схемы. Схемы можно передать в Microwave 

Office, щёлкнув мышкой по кнопке MWO в левом верхнем углу 
схемы. Там они будут отображены с реальными значениями 
ширины проводников и зазоров в отрезках связанных линий, и 
будет ясно, почему схемы нельзя реализовать (ширины провод-
ников и зазоров – отрицательные). Анализ таких схем в Micro-
wave Office проводиться не будет. 

Сделайте установки в области Line Parameters, как по-
казано на рис. 3.5 и щёлкните мышкой по кнопке Circuits. Син-

тезированная схема на короткозамкнутых шлейфах с емкостной связью показана на рис. 3.6. 

Щёлкните мышкой по кнопке Freq в ле-
вом верхнем углу схемы. Рассчитанный график 
показан на рис. 3.7. Поместите курсор на гра-
фик, нажмите левую кнопку мышки и, передви-
гая мышку, установите маркер на частоту 8 
ГГц. Щёлкните правой кнопкой мышки, чтобы 
зафиксировать маркер. Снимая или устанавли-
вая “галочки” в соответствующих переключа-
телях в правой верхней части окна графика, 
можно удалять или добавлять желательные ха-
рактеристики на графике. 

Чтобы передать схему в Microwave Of-
fice, щёлкните мышкой по кнопке MWO в ле-

Рис. 3.2 

Рис. 3.3 Рис. 3.4 

Рис. 3.5 

Рис. 3.6 

Рис. 3.7
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вом верхнем углу окна схемы рис. 3.6. Переданная в Microwave Office схема выглядит, как 
показано на рис. 3.8, а график, рассчитанный в Microwave Office, показан на рис. 3.9. 

Чтобы установить маркер в Microwave 
Office, выберите в меню Graph>Marker>Add 
Marker. 

Характеристика несколько сдвинута 
вниз по частоте. Исправить это можно, вы-
полнив оптимизацию или настройку. 

Такая структура с емкостной связью 
имеет меньшую длину, по сравнению со схе-
мой на шлейфах со связью через отрезки ли-
ний. Она может использоваться, если плата 
фильтра должна иметь меньшие габариты. 

Заметим, что для передачи подобной 
схемы в Microwave Office нет смысла отме-
чать Show Layout, т.к. в Microwave Office нет 
элемента топологии, соответствующего кон-
денсатору и автоматически правильная топо-

логия схемы не будет создаваться. Такой топологический элемент необходимо будет создать 
непосредственно в Microwave Office. 

Откройте Nuhertz Filter, щёлкнув мышкой по имени 
этой программы на панели задач Windows. Закройте окна 
схемы и графика. 

Сделайте установки в области Line Parameters, как 
показано на рис. 3.10 и щёлкните мышкой по кнопке Cir-
cuits. Откроются два окна со схемами, которые начинают-
ся с последовательного элемента (рис. 3.11) и параллель-
ного элемента (рис. 3.12). 

Щёлкните мышкой по кнопке Freq в левом верхнем углу первой схемы, показанной 
на рис. 3.11. Затем щёлкните мышкой по кнопке Freq в левом верхнем углу второй схемы, 
показанной на рис. 3.12. 

Рис. 3.8 

Рис. 3.9

Рис. 3.10 

Рис. 3.11 Рис. 3.12 
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Графики характеристик, рассчитанные в Nuhertz Filter, показаны на рис. 3.13 и 3.14. 
Из этих графиков видно, что характеристика для схемы с первым параллельным элементом 
рис. 3.12, имеет более крутой скат. Эту схему и оставим для дальнейшего моделирования. 
Закройте окна другой схемы и её графика. 

Заметим, что рассчитанные характеристики обеих схем сдвинуты вверх, но их на-
стройку удобнее выполнить в Microwave Office. 

Щёлкните мышкой по кнопке MWO в левом верхнем углу схемы, откроется окно рис. 
3.15. 

В этом окне: 

Рис. 3.13 Рис. 3.14 

Рис. 3.15

1. В поле Schematic Name введите имя схемы F_High. Отметьте Simulate After Export, 
Include Optimization Goals и Show Layout. Хотя это и не обязательно, все эти опера-
ции можно сделать и непосредственно в Microwave Office. 

2. Отметьте тип графика Rectangular и снимите отметки для всех остальных графиков. 
3. В области Rectangular Measurement отметьте Forward Transfer (S21) и снимите все 
остальные отметки. 

4. В областях Impedance/Admittance и Other снимите все отметки. 
5. Щёлкните мышкой по кнопке Append to MWO. 

Щёлкните мышкой по окну Microwave Office или по имени этой программы на панели 
задач Windows, чтобы перейти в интерфейс Microwave Office. 

Переданная в Microwave Office схема выглядит, как показано на рис. 3.16, а рассчи-
танный в Microwave Office график – на рис. 3.17. 
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Рис. 3.16

 
Щёлкните правой кнопкой 

мышки по графику и выберите Prop-
erties. В открывшемся окне на 
вкладке Axis для оси x снимите “га-
лочку” в Auto divs и в поле Step вве-
дите 1. Для оси Left 1 снимите “га-
лочки” в Auto limits и в Auto divs, в 
поле Min введите -80, в поле Max 
введите 0 и в поле Step введите 5, 
нажмите Apply и OK. 

Характеристика фильтра 
сдвинута вверх по частоте. Восполь-
зуемся блоком настройки. Причём 
длину и ширину проводников будем 
округлять до пяти сотых, предпола-
гая, что размер сетки в электромаг-

нитной структуре будет 
равен 0.05 мм. 

Сделайте актив-
ным окно графика и 
щёлкните мышкой по 
значку Tune на панели 
инструментов. Двигая 
движки на блоке настрой-
ке, добейтесь желаемой 
характеристики (рис. 
3.18). 

Сделайте актив-
ным окно схемы и до-
бавьте 50-омные провод-
ники на входе и выходе 
фильтра. Для этого: 

Рис. 3.17 
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1. Нажмите клавишу 

Ctrl, установите 
курсор на входной порт, нажмите левую кнопку мышки и переместите порт на свобод-
ное место в окне схемы, прервав соединение порта со схемой. 

Рис. 3.18

2. Повторите п.1 для выходного порта. 



3. Откройте окно просмотра элементов, щёлкнув по кнопке Elements в левой нижней 
части окна проекта. 

4. Раскройте группу Microscrip и щёлкните мышкой по подгруппе Lines. Перетащите 
элемент MLIN в окно схемы и подключите его ко входу схемы. 

5. Дважды щёлкните по элементу MLIN и в открывшемся окне свойств элемента введите 
W=0.45 mm и L=3 mm, нажмите OK. 

6. Щёлкните по значку Copy и затем по значку Paste на панели инструментов (элемент 
MLIN должен быть выделен). Подключите скопированный элемент к выходу схемы. 

7. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите 
порт ко входу схемы. Аналогично подключите порт к выходу схемы. 
Должна получиться схема рис. 3.19. 

Создайте топологию схемы. Для этого: 

Рис. 3.19 

1. Откройте окно просмотра проекта, щёлкнув мышкой по кнопке Project в левой ниж-
ней части окна. 

2. Щёлкните мышкой по значку New Schematic Layout View на панели инструментов. 
3. В окне ввода Grid Spacing на панели инструментов введите 0.5х, чтобы сделать раз-
мер ячеек сетки 0.05 мм. 

4. Выделите все элемен-
ты топологии и щёлк-
ните мышкой по знач-
ку Snap Together на 
панели инструментов, 
чтобы упорядочить 
топологию. 

Созданная топология схемы показана на рис. 3.20. 
Щёлкните мышкой по значку Measure на панели инструментов, установите курсор на 

правый верхний край выходного проводника, нажмите левую кнопку мышки и, не отпуская 
кнопки, переместите курсор на левый верхний край входного проводника (рис. 3.20). Изме-
ренная длина топологии равна 18 мм. Измеренная аналогично ширина топологии равна 2.5 
мм. 

Создайте электромагнитную структуру: 

Рис. 3.20 

1. Щёлкните по значку New EM Structure на панели инструментов, введите имя элек-
тромагнитной структуры Fil_High, отметьте AWR EMSight Simulator и нажмите Cre-
ate. 

2. Щёлкните по значку Substrate Information на панели инструментов, откроется окно 
Element Options. 

3. На вкладке Enclosure введите X_Dim=18 mm, Y_Dim=5 mm, Grid_X=0.05 и 
Grid_Y=0.05. 

4. На вкладке Material defs введите Er=10.43 и TanD=0.0001. 
5. На вкладке Dielectric Layers введите для слоя 1 толщину 6 mm, для слоя 2 толщину 

0.5 mm. 
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6. На вкладке Materials отметьте 1/2oz Cu. 
7. Нажмите OK. 
8. Сделайте активным окно топологии схемы, выделите всю топологию и щёлкните по 
значку Copy на панели инструментов. 

9. Сделайте активным окно элек-
тромагнитной структуры и 
щёлкните по значку Paste на 
панели инструментов. 
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-
нитная 

им

 

ь

жав клавишу Shift, 

е по оставшим-

10. Вставьте скопированную топо-
логию в корпус так, чтобы края 
входного и выходного провод-
ников точно совпадали с левым 
и правым раем корпуса соответ-

ственно. 
Электромаг
структура 

должна еть вид, 
показанный на рис. 
3.21. Щёлкните по 
значку View Area на 
панели инструментов 
и увелич те несколь-
ко первых элементов 

топологии, чтобы была видна сетка, как показано на рис. 3.22. Расположение некоторых эле-
ментов топологии не совпадает с сеткой. Эти несовпадения не велики и можно надеяться, 
что погрешность моделирования будет незначительной. Но, для удобства дальнейшей рабо-
ты с топологией, её лучше отредактировать. Это можно сделать разными способами, исполь-
зуя возможности редактора топологии. Мы это сделаем следующим образом, сократив коли-

чество топологических эле-
ментов. 

1. На

Рис. 3.21 

Рис. 3.22

щёлкните по трём эле-
ментам, соединяющим 
первый и второй шлей-
фы, и по трём элементам, 
соединяющим предпо-
следний и последний 
шлейфы. Нажмите кла-
вишу Delete, чтобы 
удалить эти элементы. 

2. Нажав клавишу Shift, 
щёлкнит

Рис. 3.23 

ся элементам тополо-
гии, которые располо-
жены между входным и 
выходным проводника-
ми. Оставшаяся тополо-
гия с выделенными 
проводниками будет 

выглядеть, как показано на рис. 3.23. 
Рис. 3.24 

3. Щёлкните по значку View Area на панели инструментов и увеличьте средние элемен-
ты топологии. Установите курсор на один из выделенных элементов, нажмите левую 
кнопку мышки и нажмите клавишу Tab. Появится окно для координатного ввода (рис. 
3.24). В поле dy введите 0.025 и нажмите OK. 



4. Отобразите увеличенные первый и второй шлейфы (можно воспользоваться горизон-
тальной полосой скроллинга в нижней части окна). Щёлкните по значку Polygon на па-

нели инструментов. Уста-
новите курсор на правый 
верхний угол входного 
проводника, щёлкните ле-
вой кнопкой мышки и за-
тем перемещайте курсор 
следующим образом, щёл-
кая мышкой после каждо-
го перемещения: вправо на 
0.35, вверх на 0.05, вправо 
на 3.7, вниз на 0.1, вправо 
на 0.35, вниз на 0.4, влево 

на 4.4 и здесь дважды щёлкните мышкой. Отредактированный фрагмент топологии 
должен выглядеть, как показано на рис. 3.25. 

Рис. 3.25 

5. Оставив созданный 
элемент выделенным, 
выберите в меню 
Edit>Mirror, пере-
местите курсор в окно 
схемы и, двигая мыш-
кой, создайте зер-
кальную копию этого 
элемента. Вставьте 
полученный элемент 

между предпоследним и последним шлейфами. 
Отредактированная топология показана на рис. 3.26. Выделите все элементы тополо-

гии, щёлкните правой кнопкой мышки по любому выделенному элементу и выберите Shape 
Properties. В открывшемся окне свойств выберите материал 1/2oz Cu и нажмите OK. 

Щёлкните мышкой по входному проводнику, чтобы выделить его. Затем щёлкните 
мышкой по значку Edge Port на панели инструментов, поместите курсор на левый край 
входного проводника так, чтобы появился небольшой прямоугольник, и щёлкните левой 
кнопкой мышки. Выделите порт щелчком мышки, установите курсор на правую сторону 
прямоугольника так, чтобы курсор отображался в виде двойной стрелки, нажмите левую 
кнопку мышки и переместите референсную плоскость порта на 1 мм вправо. Аналогично ус-
тановите порт на выходе схемы. 

Теперь создайте заземление шлейфов. Например, шлейфы можно заземлить через ме-
таллизированные отверстия на краях шлейфов, введя в топологию межслойные перемычки 
(Via). Мы создадим заземление следующим образом. 

Рис. 3.26 

1. Выделите всю топологию. Установите курсор на любой элемент топологии и, нажав 
левую кнопку мышки, сдвиньте топологию по вертикали так, чтобы расстояние от края 
первого шлейфа до нижнего края корпуса было равно 0.3.мм. 

2. Щёлкните мышкой по значку Polygon на панели инструментов. 
3. Установите курсор на левый нижний край первого шлейфа и щёлкните левой кнопкой 
мышки. Перемещайте курсор, щёлкая мышкой после каждого перемещения, вниз на 
0.3, вправо на 12, вверх на 0.3, влево на 2.2, вверх на 0.35, влево на 7.6, вниз на 0.35, 
влево на 2.2 и здесь дважды щёлкните левой кнопкой мышки. 

4. Щёлкните правой кнопкой мышки по выделенному заземляющему проводнику и вы-
берите Shape Properties. В открывшемся окне свойств выберите материал 1/2oz Cu и 
нажмите OK. 
Топология должна выглядеть, как показано на рис. 3.27. 
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Для выполнения анализа опреде-
лим частоты, общие для проекта и изме-
ним опции схемы, для использования 
частот проекта. Затем изменим свойства 
измеряемой величины на графике так, 
чтобы отображались характеристики и 
схемы, и графика. 
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1. Дважды щёлкните по Project Op-

tions в левом окне проекта. На вкладке Frequencies открывшегося окна в поле Start 
(GHz) введите 0, в поле Stop (GHz) введите 18, в поле Step (GHz) введите 1, отметьте 
Replace, нажмите Apply и OK. 

Рис. 3.27 

2. Щёлкните правой кнопкой мышки по имени схемы F_High в левом окне проекта и 
выберите Options. В открывшемся окне на вкладке Frequencies отметьте Use project 
default и нажмите OK. 

3. Щёлкните правой кнопкой мышки по имени электромагнитной структуры Fil_High в 
левом окне проекта и выберите Options. В открывшемся окне на вкладке Frequencies 

отметьте Use project default и на-
жмите OK. 

4. Щёлкните правой кнопкой мышки 
по имени измеряемой величины 
F_High:DB(|(S2,1)|) в группе графи-
ков в левом окне просмотра проекта 
и выберите Properties. В открыв-
шемся окне в поле Data Source 
Name введите All Sources и нажмите 
OK. 

5. Откройте окно графика и щёлкните 
по значку Analyze на панели инст-
рументов. Рассчитанный график по-
казан на рис. 3.28. 
Характеристика электромагнитной 

структуры отличается от характеристики 
схемы. Этого следовало ожидать, посколь-

ку схема не совсем точно отражает особенности топологии фильтра. 
Сделайте активным окно электромагнитной структуры и отредактируйте топологию. 

Характеристику нужно сдвинуть вверх по частоте, т.е. нужно укоротить длину шлейфов. Для 
этого дважды щёлкните мышкой по пер-
вому шлейфу. Установите курсор на ром-
бик посередине нижней стороны шлейфа и 
сдвиньте эту сторону вверх на 0.4 мм. 
Аналогично укоротите все остальные 
шлейфы. Нажмите клавишу Shift и выде-
лите все элементы топологии фильтра, 
кроме заземляющего проводника. Устано-
вите курсор на любой выделенный эле-
мент топологии и сдвиньте выделенную 
топологию вниз на 0.4 мм до соединения 
шлейфов с заземляющим проводником. 
Щёлкните по значку Analyze на панели 
инструментов. Рассчитанный график пока-
зан на рис. 3.29. Характеристика электро-
магнитной структуры хорошо совпадает с 
характеристикой схемы. 

Рис. 3.28 

Рис. 3.29



4. Полосно-пропускающие фильтры 
Для всех примеров проектирования фильтров в этом разделе для частот используются 

единицы измерения ГГц и метрическая система для единиц измерения длины. Поэтому лю-
бой пример должен начинаться с загрузки Microwave Office и выбора в меню Op-
tions>Project Options. На вкладке Global Units открывшегося окна опций проекта нужно 
ввести единицы измерения для частот GHz, отметить Metric units, для единиц измерения 
длины ввести mm и нажать OK. Затем раскройте группу Wizards в левом окне просмотра 
проекта и дважды щёлкните по Nuhertz Filter Wizard, чтобы открыть окно Filter Synthesis. 

4.1. Фильтр на замкнутых шлейфах с полосой пропускания 4-8 ГГц 
Требуется спроектировать фильтр с полосой пропускания от 4 до 8 ГГц. 

На вкладке Topology (рис. 4.1): 
1. В поле Implementation (Реализация) 
введите Microstrip. 

2. В поле Shape (Вид) введите Chebyshev 
I. 

3. В поле Type введите Band Pass. 
 
На вкладке Settings (рис. 4.2): 

1. В поле Order (Порядок) введите 7. 
2. В поле Pass Band Def (Определение по-
лосы пропускания) введите Corner 
Freqs. 

3. В поле Lower Corner Frequency введи-
те 4 GHz. Рис. 4.1 

4. В поле Upper Corner Frequency введи-
те 8 GHz. 

5. Отметьте Standard Pass Band Attenua-
tion. 

6. В поле Pass Band Ripple (dB) введите 
величину пульсаций в полосе пропуска-
ния 0.05. 

7. В поле Conductor Thickness (Толщина 
проводника) введите 0.005 mm. 

8. В поле Dielectric Height (Толщина ди-
электрика) введите 0.5. 

9. В поле Dielectric Loss Tangent введите 
тангенс диэлектрических потерь 0.0001. 

 
На вкладке Defaults (рис. 4.3): 
полях

Рис. 4.2 
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1. В  Source Resistance (Сопротив-
ление источника) и Load Resistance (Со-
противление нагрузки) введите 50 Ohm. 
В2.  поле Dielectric Constant (Er) введите 
диэлектрическую проницаемость 10.35. 
В поле Frequency Where Alias3.   ing Be-

gins введите 18 GHz. 
О Coupled Resonator Internal 4. тметьте 

Impedance и в поле Center Resonator 
Impedance введите 50 Ohm. 
З ос5. начения тальных полей оставьте по 
умолчанию. 

 
Рис. 4.3 



На вкладке Schematic (рис. 4.4): 
1. В поле Schematic Name введите имя 

ude Optimization Goals 

 

 Graphs To Generate от-

и Graph Limits отметьте Sent 

меню 

Отметьте 1 st Shu и 1 st Ser в области Line Paramete а, 
чтобы 

 

 . 
емами. 

отрезка 
высоко

о

 Graphs To Generate от-

и Graph Limits отметьте Sent 

меню 

Отметьте 1 st Shu и 1 st Ser в области Line Paramete а, 
чтобы 

 

 . 
емами. 

отрезка 
высоко

о
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схемы Fil4_8. 
2. Отметьте Incl

(Включить цели оптимизации). 
3. Отметьте Generate Graphs (Создать
графики). 

4. В области
ки). 

4. В области
метьте Rectangular (Прямоугольный). 

5. В области Measurement for Rectangu-
метьте Rectangular (Прямоугольный). 

5. В области Measurement for Rectangu-
lar отметьте Forward Transfer 
dB(S21). 

6. В област

lar отметьте Forward Transfer 
dB(S21). 

6. В област
To MWO, в поле Min Freq введите 2 
GHz, в поле Max Freq введите 10 GHz. 
После ввода всех данных выберите в 

To MWO, в поле Min Freq введите 2 
GHz, в поле Max Freq введите 10 GHz. 
После ввода всех данных выберите в 
Integration>Nuhertz Interface. Откро-

ется основное окно панели управления Nuhertz Filter (рис. 4.5). В строке меню этого окна 
выберите File>Save As и сохраните синтезируемый фильтр в файле Fil4-8. 

rs в нижнем правом углу окн

Integration>Nuhertz Interface. Откро-
ется основное окно панели управления Nuhertz Filter (рис. 4.5). В строке меню этого окна 
выберите File>Save As и сохраните синтезируемый фильтр в файле Fil4-8. 

rs в нижнем правом углу окн
просмотреть два вари-

анта схемы: начинающейся с 
параллельного короткозамк-
нутого шлейфа и с последова-
тельного отрезка. Все уста-
новки должны соответство-
вать рис. 4.5. 

Щёлкните мышкой по 
кнопке Circuits Откроются 
два окна со сх

просмотреть два вари-
анта схемы: начинающейся с 
параллельного короткозамк-
нутого шлейфа и с последова-
тельного отрезка. Все уста-
новки должны соответство-
вать рис. 4.5. 

Щёлкните мышкой по 
кнопке Circuits Откроются 
два окна со сх

На рис. 4.6 показана 
схема фильтра, начинающаяся 
с последовательного 

На рис. 4.6 показана 
схема фильтра, начинающаяся 
с последовательного 

омной линии. В этой 
схеме последовательные от-
резки являются полув лновы-
ми резонаторами, а парал-
лельные короткозамкнутые 

омной линии. В этой 
схеме последовательные от-
резки являются полув лновы-
ми резонаторами, а парал-
лельные короткозамкнутые 

Рис. 4.4

Рис. 4.5 

Рис. 4.6 
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req в 
левом 

а-
раллел

ем отли-

Закройте окно схемы рис. 4.6. 
ы рис. 

4.8. В л

atic Name введите 

шлейфы – четвертьволновыми резонаторами. Связь между резонаторами – непосредствен-
ная. 

Щёлкните мышкой по кнопке F
верхнем углу схемы. Рассчитанная ха-

рактеристика фильтра показана на рис. 4.7. 
Схема фильтра, начинающаяся с п
ьного шлейфа, показана на рис. 4.8. В 

этой схеме параллельные короткозамкнутые 
шлейфы являются четвертьволновыми резо-
наторами, связь между которыми осуществ-
ляются через четвертьволновые отрезки свя-
зи. Щёлкните мышкой по кнопке Freq в ле-
вом верхнем углу схемы. Характеристика 
этого фильтра показана на рис. 4.9. 
Характеристики обоих вариантов схРис. 4.7 

чаются мало. Но в первой схеме рис.4.6 по-
следовательные отрезки имеют большое вол-
новое сопротивление и, соответственно, ма-
лую ширину (0.025 мм) и большую длину. 
Общая длина этого фильтра больше, чем у 
второго варианта. Поэтому остановимся на 
схеме фильтра, которая начинается с парал-
лельного короткозамкнутого шлейфа рис. 
4.8. 

Рис. 4.8 

Сделайте активным окно схем
евом верхнем углу этой схемы щелк-

ните мышкой по кнопке MWO. Откроется 
окно для установки опций экспорта в Micro-
wave Office рис. 4.10. 

В поле ввода SchemРис. 4.9 

Рис. 4.10



 36

имя схемы Fil4_8. Отметьте Simulate After Export, Include Optimization Goals, Forward 
Transfer (S21), Rectangular, DB и Magnitude. Снимите все остальные “галочки”. Установки 
должны быть, как показано на рис. 4.10. Щёлкните мышкой по кнопке Append to MWO в 
правом нижнем углу окна. 

Щёлкните по окну Microwave Office или по имени этой программы на панели задач 
Windows, чтобы сделать её активной. Переданные схема и график, рассчитанный в Micro-
wave Office, будут выглядеть, как показано на рис. 4.11. 

Рис. 4.11

Характеристика, рассчитанная в 
Microwave Office, сдвинута вниз по час-
тоте и уже требуемой. Чтобы исправить 
это, воспользуемся оптимизацией. 

рассчитанная в 
Microwave Office, сдвинута вниз по час-
тоте и уже требуемой. Чтобы исправить 
это, воспользуемся оптимизацией. 

Щёлкните мышкой по окну графи-
ка, чтобы сделать его активным. Затем 
выберите в меню Simulate>Optimize. В 
открывшемся окне выберите метод опти-
мизации Pointer – Robust Optimization, 
установите Maximum Iterations равным 
500 и нажмите Start. Полученная харак-
теристика показана на рис. 4.12. 

Щёлкните мышкой по окну графи-
ка, чтобы сделать его активным. Затем 
выберите в меню Simulate>Optimize. В 
открывшемся окне выберите метод опти-
мизации Pointer – Robust Optimization, 
установите Maximum Iterations равным 
500 и нажмите Start. Полученная харак-
теристика показана на рис. 4.12. 

Сделайте активным окно схемы, 
щёлкнув мышкой по этому окну или 
дважды щёлкнув мышкой по имени схе-
мы в левом окне просмотра проекта. Ок-

руглите значения переменных до одной десятой. Для этого дважды щёлкните мышкой по пе-
ременной W1 и измените её значение на 0.3. Аналогично отредактируйте все переменные, 
установив их значения, как показано на рис. 4.13. 

Сделайте активным окно схемы, 
щёлкнув мышкой по этому окну или 
дважды щёлкнув мышкой по имени схе-
мы в левом окне просмотра проекта. Ок-

руглите значения переменных до одной десятой. Для этого дважды щёлкните мышкой по пе-
ременной W1 и измените её значение на 0.3. Аналогично отредактируйте все переменные, 
установив их значения, как показано на рис. 4.13. 

Рис. 4.12



Добавьте в проект частоты для моделирования. Дважды щёлкни-
те по Project Options в левом окне просмотра проекта. В открывшемся 
окне опций проекта на вкладке Frequencies отметьте Replace, в поле 
Start (GHz) введите 2, в поле Stop (GHz) введите 10, в поле Stop (GHz) 
введите 0.5, нажмите Apply и OK. 

Щёлкните правой кнопкой мышки по имени схемы в правом окне 
просмотра проекта и выберите Options. В открывшемся окне опций 

схемы на вкладке Frequencies отметьте Use project default и нажмите OK. 
Рис. 4.13 

Чтобы на графике наблюдать характеристики и схемы, и электромагнитной структу-
ры, отредактируйте свойства графика. 

1. Сделайте активным окно графика, дважды щёлкнув по его имени в левом окне проек-
та. Щёлкните правой кнопкой мышки по имени измеряемой величины 
Fil4_8:DB(|S(2,1)|) в левом окне проекта и выберите Properties. В открывшемся окне в 

поле Data Source Name введите All Sources и 
нажмите OK. 
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2. Щёлкните по значку Analyze на панели инст-
рументов. 

3. Щёлкните правой кнопкой мышки по графи-
ку и выберите Properties. 

4. В открывшемся окне свойств графика на 
вкладке Axes для оси x снимите “галочку” в 
Auto divs и в поле Step введите 0.5. Для оси 
Left 1 снимите “галочки” в Auto limits и Auto 
divs. В поле Min введите 60, в поле Step вве-
дите 5. Нажмите Apply и OK. 
Полученный график показан на рис. 4.14. 
Добавьте отрезки 50-омных линий на входе и 

выходе фильтра. 
Рис. 4.14 

1. Щёлкните мышкой по кнопке Elements в нижней части левого окна проекта, чтобы 
открыть окно просмотра элементов. 

2. Раскройте группу Microstrip и щёлкните мышкой по подгруппе Lines. 
3. Установите курсор на входной порт, нажмите клавишу Ctrl и левую кнопку мышки. 
Переместите порт на свободное место в окне схемы, разорвав связь порта со схемой. То 
же самое сделайте с выходным портом. 

4. Перетащите элемент MLIN в окно схемы и подключите его ко входу схемы. 
5. Дважды щёлкните мышкой по элементу MLIN и в окне свойств элемента введите 

W=0.45, L=3 и нажмите OK. 
6. Щёлкните по значку Copy и затем по значку Paste (элемент MLIN должен быть выде-
лен) на панели инструментов. 

7. Подключите скопированный элемент к выходу схемы. 
8. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите 
порт ко входу схемы. Аналогично подключите порт к выходу схемы. Схема будет вы-
глядеть, как показано на рис. 4.15. 

Рис. 4.15 



Теперь создадим электромагнитную структуру. 
1. Сделайте активным окно схемы. 
2. Щёлкните по значку New Schematic Layout View  на панели инструментов. 
3. Установите курсор левее и выше созданной топологии, нажмите левую кнопку мышки 
и, не отпуская кнопки, переместите курсор правее и ниже топологии так, чтобы вся то-
пология попала в образовавшийся прямоугольник. Или выберите в меню Edit>Select 
All. Вся топология должна быть выделена. 

4. Выберите в меню Edit>Snap Together или щёлкните по значку Snap Together  на 
панели инструментов, чтобы упорядочить топологию. 

5. В поле ввода Grid Spacing на панели инструментов (рис. 4.16) вве-
дите множитель 0.5x, чтобы размер клеток сетки сделать равным 
0.05 мм. 

6. Щёлкните мышкой по значку View Area на панели инструментов и 
увеличьте отображение входного проводника вместе с первым Т-
сочленением так, чтобы была видна сетка (рис. 4.17). Топология 
входного проводника не совпадает с сеткой и по вертикали, и по го-

ризонтали. Поскольку в электромагнитной структуре порт должен точно совпадать с 

сеткой, на такой проводник порт не установится, и анализ проводиться не будет. По-
этому отредактируем положение входного проводника. 

Рис. 4.16 

Рис. 4.17

7. В поле ввода Grid Spacing на панели инструментов вве-
дите множитель 0.1x, чтобы размер клеток сетки сделать 
равным 0.01 мм. 

8. Установите курсор на входной проводник, нажмите ле-
вую кнопку мышки и переместите этот проводник вниз 
так, чтобы его нижняя сторона была на одном уровне с 
нижней стороной Т-разветвителя (рис. 4.18). Аналогично 
отредактируйте выходной проводник. 

9. Выберите в меню Edit>Select All, чтобы выделить всю 
топологию. Рис. 4.18 

10. Установив курсор на любой проводник и, нажав левую кнопку мышки, сдвиньте всю 
топологию влево на 0.1 мм. 

Рис. 4.19

11. В поле ввода Grid Spacing на панели инструментов введите множитель 0.5x, чтобы 
размер клеток сетки сделать равным 0.05 мм. Убедитесь, что проводники совпадают с 
сеткой. Полученная топология с размерами, необходимыми для создания электромаг-
нитной структуры, показана на рис. 4.19. 
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Теперь можно приступать к созданию электромагнитной структуры. 
1. Щёлкните мышкой по кнопке Project в нижней части левого окна, чтобы открыть ок-
но просмотра проекта. 

2. Щёлкните мышкой по значку New EM Structure на панели инструментов или выбери-
те в меню Project>Add EM Structure>New EM Structure. 

3. В открывшемся окне введите имя структуры F4_8, отметьте AWR EMSight Simulator 
и нажмите Create. 

4. Щёлкните мышкой по значку Substrate Information на панели инструментов или 
дважды щёлкните по Enclosure под именем электромагнитной структуры в левом окне 
просмотра проекта. 

5. В открывшемся окне свойств на вкладке Enclosure введите X_Dim=39.3, Y_Dim=7, 
Grid_X=0.05 и Grid_Y=0.05. 

6. На вкладке Material Defs введите Er=10.35, TanD=0.0001. 
7. На вкладке Dielectric Layers введите для слоя 1 толщину 4, для слоя 2 толщину 0.5. 
8. Нажмите OK. 
9. Сделайте активным окно топологии схемы и выделите всю топологию. 
10. Щёлкните мышкой по значку Copy на панели инструментов. 
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вый и правый края точно совпадали с краями корпуса (рис. 4.20). 

ю. Установите курсор 

ели инструментов. Установите курсор на ле-

11. Сделайте активным окно электромагнитной структуры и щёлкните мышкой по значку 
Paste на панели инструментов. Вставьте скопированную топологию так, чтобы её ле-

12. Выберите в меню Edit>Select All, чтобы выделить всю топологи
Рис. 4.20

на любой элемент топологии, нажмите левую кнопку мышки и пере-
местите топологию по вертикали так, чтобы расстояние от нижнего 
края первого шлейфа до края корпуса было равно 0.3 мм (рис. 4.21). 

13. Создайте заземляющий проводник. Щёлкните левой кнопкой мышки 
по значку Polygon на пан
вый нижний угол первого шлейфа, щёлкните левой кнопкой мышки и 
перемещайте курсор, щёлкая мышкой после каждого перемещения, 
следующим образом: вправо на 2.5, вверх на 0.6, вправо на 5.6, вверх 

на 0.2, вправо на 17.1, вниз на 0.2, вправо на 5.6, вниз на 0.6, вправо на 2.5, вниз на 0.3, 
влево на 33.3 и здесь дважды щёлкните левой кнопкой мышки. 

14. Выделите входной проводник. Щёлкните левой кнопкой мышки по значку Edge Port 
на панели инструментов, установ

Рис. 4.21 

ите курсор на левый край входного проводника так, 
чтобы появился небольшой прямоугольник, и щёлкните левой кнопкой мышки. Щёлк-
ните мышкой по установленному порту, чтобы выделить его, установите курсор на 
правый край порта так, чтобы курсор отображался в виде двойной стрелки. Нажмите 
левую кнопку мышки и переместите референсную плоскость порта вправо на 1 мм. 
Аналогично установите порт на выходе фильтра. 
Должна получиться топология, показанная на рис. 4.22. 

Рис. 4.22 
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у Analyze на панели инстру-
ментов

 по пер-
вому ш

зана на рис. 4.25. 

и с полосой пропуска-
ния 9

 единиц Metric units. Загрузите Nuhertz Filter Wizard, 

Сделайте активным окно графика и щёлкните по значк
. Рассчитанный график показан на рис. 

4.23. Характеристика электромагнитной 
структуры сдвинута вниз по частоте. 

Сделайте активным окно электромаг-
нитной структуры. Дважды щёлкните

лейфу, установите курсор на ромбик 
посередине нижней стороны шлейфа, нажми-
те левую кнопку мышки и сдвиньте эту сто-
рону на 0.6 мм вверх. Аналогично укоротите 
все шлейфы фильтра. Нажмите клавишу Shift 
и поочерёдно щёлкните по всем элементам 
фильтра, кроме заземляющего проводника. 
Установите курсор на любой выделенный 
элемент и, нажав левую кнопку мышки, 
сдвиньте элементы фильтра на 0.6 мм вниз 
до соединения с заземляющим проводником. 
Сделайте активным окно графика и щёлкни-
те мышкой по значку Analyze на панели ин-
струментов. Рассчитанный график показан 
на рис. 4.24. Характеристика электромагнит-
ной структуры хорошо совпадает с характе-
ристикой схемы. 

Отредактированная электромагнитная 
структура фильтра пока

 
 

Рис. 4.23

Рис. 4.24 

Рис. 4.25 

4.2. Фильтр с боковыми электромагнитными связям
-9.5 ГГц 
Загрузите Microwave Office, установите глобальные единицы измерения для частоты 

GHz и  системуотметьте метрическую
чтобы открыть окно Filter Synthesis. 

На вкладке Topology: 
1. В поле Implementation (Реализация) введите Microstrip. 
2. В поле Shape (Вид) введите Chebyshev I. 
3. В поле Type введите Band Pass. 

На вкладке Settings: 
1. В поле Order (Порядок) введите 5. 
2. В поле Pass Band Def (Определение полосы пропускания) введите Corner Freqs. 
3. В поле Lower Corner Frequenc . y введите 9 GHz



 41

.5 GHz. 
tenuation. 

6. ple (dB) введите величину пульсаций в полосе пропускания 0.05. 
на проводника) введите 0.005 mm. 

электрических потерь 0.0001. 

4. В поле Upper Corner Frequency введите 9
5. Отметьте Standard Pass Band At

В поле Pass Band Rip
7. В поле Conductor Thickness (Толщи
8. В поле Dielectric Height (Толщина диэлектрика) введите 0.5. 
9. В поле Dielectric Loss Tangent введите тангенс ди

На вкладке Defaults: 
1. В полях Source Resistance (Сопротивление источника) и Load Resistance (Сопротив-

ь 10.35. 

rallel 
Coupled Open Resonators, щёлкнув по кнопке в правом конце этого поля. 

ление нагрузки) введите 50 Ohm. 
2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемост
3. В поле Frequency Where Aliasing Begins введите 18 GHz. 
4. Отметьте Coupled Resonator Filter и в поле Coupled Res Filter Type введите Pa

5. Отметьте Coupled Resonator Internal Impedance и в поле Center Resonator Imped-
ance введите 50 Ohm. 

6. Значения остальных полей оставьте по умолчанию. 
На вкладке Schematic: 

1. В поле Schematic Name введите имя схемы Fil9_95. 
2. В области Schematic Generation отметьте Append. 
3. Отметьте Include Optimization Goals (Включить цели оптимизации). 
4. Отметьте Generate Graphs (Создать графики). 

r (Прямоугольный) и снимите от-
м  типов графиков. 

rward Transfer dB(S21). 
поле Min Freq введите 8.5 GHz, в 

egration>Nuhertz Interface. Откроется 

ром
все

 в 

Circuits в нижнем пра-

окна панели управле-

Щёлкните мыш-
кой по кнопке Freq в 
верхнем левом углу 
окна схемы. Рассчи-
танная Nuhertz Filter 
характеристика пока-

5. В области Graphs To Generate отметьте Rectangula
етки для всех остальных

6. В области Measurement for Rectangular отметьте Fo
7. В области Graph Limits отметьте Sent To MWO, в 
поле Max Freq введите 10 GHz. 
После ввода всех данных выберите в меню Int

основное окно па-
нели управления 
Nuhertz Filter 
(рис. 4.26), в кото-

 определены 
 ранее сделан-

ные установки. В 
строке меню этого 
окна выберите 
File>Save As и со-
храните синтези-
руемый фильтр
файле Fil9-95. 

Щёлкните 
мышкой по кнопке 

Рис. 4.26 

вом углу открывшегося 

ния. Синтезированная 
схема фильтра показа-
на на рис. 4.27. 

Рис. 4.27
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зана на

левом 
верхне

matic Name введите имя 
схемы

ngular 

Отметь-

 

ышкой 

ема 

 рис. 4.28. 
Чтобы передать синтезированную 

схему фильтра в Microwave Office, щёлк-
ните мышкой по кнопке MWO в 

м углу окна схемы рис. 4.27. Откро-
ется окно установки опций для передачи 
схемы в Microwave Office рис. 4.29. 

В поле Sche
 Fil9_95. 
Отметьте Simulate After Export, 

чтобы сразу после передачи был выполнен 
анализ схемы, и Include Optimization 
Goals, чтобы добавить цели оптимизации. 

Отметьте тип графика Recta

(Прямоугольный) и уберите отметки во всех остальных типах графиков. 

те Forward 
Transfer (S21) 
и снимите от-
метки у всех 

остальных
единиц изме-
рения. 

Щёлк-
ните м
по кнопке Ap-
pend to MWO 
в правом ниж-
нем углу окна. 
На рис. 4.30 
показаны пе-
реданная сх
и рассчитанная 
в Microwave 
Office характе-
ристика. 

Опреде-

Рис. 4.28

Рис. 4.29

Рис. 4.30
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r
те 8.5, в поле Stop (GHz) введите 

10, в п

uencies открывшегося окна 
отметь

.

ите OK. Щёлкните мышкой по 
значку

е 
-60   

. 4.33. Значения переменных 
получили значения, которые показаны на 
рис. 4.34. 

 

вным окно
тых, как показано на рис. 4.

кая левой кнопкой мышки нным. 
к вным ика и щёлкните м

лим частоты проекта. Дважды щёлкните мышкой по Project Options в левом окне проекта. В 
открывшемся окне опций рис. 4.31 на 
вкладке F equencies в поле Start (GHz) 
введи

оле Step (GHz) введите 0.1, от-
метьте Replace, нажмите Apply и OK. 

Щёлкните правой кнопкой мыш-
ки по имени схемы Fil9_95 в левом ок-
не проекта и выберите Options. На 
вкладке Freq

те Use project defaults и нажмите 
OK  

Щёлкните правой кнопкой мыш-
ки по имени измеряемой величины 
Fil9_95:DB(|S(2,1)|) в графике в левом 
окне проекта и выберите Properties. В 
поле Data Source Name введите All 
Sources, чтобы на одном графике мож-
но было отобразить характеристики и 
схемы, и электромагнитной структуры, 
нажм

 Analyze на панели инструмен-
тов. 

Сделайте активным окно графи-
ка. Щёлкните по графику правой кноп-
кой мышки и выберите Properties. На 
вкладе Axes окна свойств графика (рис. 
4.32) для оси x снимите “галочку” в 
Auto divs и в поле Step введите 0.1. Для 
оси Left 1 снимите “галочки” в Auto 
limits и в Auto divs. В поле Min введит

, в поле Max введите 0, в поле Step 
введите 5, нажмите Apply и OK. 

Теперь выполните оптимизацию. 
Выберите в меню Simulate>Optimize. В по-
ле Optimization Methods введите метод оп-
тимизации Pointer – Robust Optimization, 
щёлкнув по кнопке в правом конце этого 
поля, в поле Maximum Iteration введите 
500, нажмите Start. Полученный график по-
казан на рис

 
 
 

 
Сделайте акти  схемы и округлите значения пе-

ременных до пяти со 35, дважды щёл-

Рис. 4.31 

Рис. 4.32 

Рис. 4.34 Рис. 4.33 

по переме
 окно графСделайте а ти ышкой по 

значку Analyze на панели инструментов, чтобы убедиться, что характеристика почти не из-
менилась. 

Рис. 4.35 
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i

Добавим 50-омные отрезки на входе и выходе фильтра. Сделайте активным окно схе-
мы. Установите курсор на входной порт, 
нажмите клавишу Ctrl и левую кнопку 
мышки. Переместите входной порт на сво-
бодное место в окне схемы, прервав связь 
порта со схемой. Аналогично сместите вы-
ходной порт. Откройте окно просмотра эле-
ментов в левом окне проекта и раскройте 
группу Microstrip. Щёлкните мышкой по 
подгруппе L nes, перетащите элемент MLIN 
в окно схемы и соедините его со входом 
схемы. Дважды щёлкните по добавленному 
элементу MLIN. В открывшемся окне 
свойств элемента введите значения W=0.45 

и L=3 (рис.4.36). Щёлкните мышкой по значку Copy и затем по значку Paste на панели инст-
рументов (элемент MLIN должен быть выделен) и подключите скопированный элемент к 
выходу схемы. Установите курсор на входной порт, нажмите левую кнопку мышки и под-
ключите порт ко входу схемы. Аналогично подключите выходной порт к выходу схемы. 
Схема должна иметь вид, показанный на рис. 4.37. 

Откройте окно просмотра проекта Project в левом окне, сделайте активным окно гра-
фика и щёлкните мышкой по значку Analyze на панели инструментов, чтобы убедиться, что 
характеристика схемы практически не изменилась. 

Сделайте активным окно схемы и щёлкните мышкой по значку New Schematic Layout 
View на панели инструментов, чтобы создать топологию схемы. Выберите в меню 
Edit>Select All, чтобы выделить всю топологию. Щёлкните по значку Snap Together на па-
нели инструментов, чтобы упорядочить созданную топологию. В поле Grid Spacing введите 
0.5, чтобы размер сетки сделать 0.05 мм. Созданная топология показана на рис. 4.38. 

Рис. 4.36 

Рис. 4.37

Рис. 4.38 



Щёлкните по значку View Area на панели инструментов и увеличьте отображение 
входного проводника так, чтобы была видна 
сетка (рис. 4.39). Видно, что в данном случае 
входной проводник не совпадает с сеткой по 
вертикали. Установите курсор на входной 
проводник, нажмите левую кнопку мышки и 
затем клавишу Tab. В открывшемся окне 
Enter Coordinates в поле dy введите 0.025 и 
нажмите OK. Входной проводник сдвинется 
вверх на 0.025 мм и совпадёт с сеткой. Ана-

логично сдвиньте вы-
ходной проводник вниз, 
введя в окне Enter Co-
ordinates в поле dy зна-
чение -0.025. 

Теперь создадим 
электромагнитную 

структуру. 

Рис. 4.39 

1. Щёлкните по 
значку New EM Structure на панели инструментов, создайте структуру с именем F9_95 
и отметьте AWR EMSight Simulator. 

Рис. 4.40 

2. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне свойств структуры на вкладке Enclosure введите X_Dim=23.1 mm, Y_Dim=9 mm, 
Grid_X=0.05 mm и Grid_Y=0.05 mm. 

3. На вкладке Material defs введите Er=10.5 и TanD=0.0001. 
4. На вкладке Dielectric Layers для слоя 1 введите толщину 6 мм и для слоя 2 – толщину 

0.5 мм. 
5. На вкладке Materials отметьте 1/2oz Cu. Нажмите OK. 
6. Сделайте активным окно топологии схемы и выделите всю топологию. Щёлкните по 
значку Copy на панели инструментов. 

7. Сделайте активным окно электромагнитной структуры и щёлкните по значку Paste на 
панели инструментов. Вставьте скопированную топологию в корпус так, чтобы левый и 
правый края входного и выходного проводников точно совпадали с левым и правым 
краями корпуса соответственно. 

8. Выделите всю топологию, щёлкните по любому элементу топологии правой кнопкой 
мышки и выберите Shape Properties. В открывшемся окне в поле Material введите 
1/2oz Cu. 

9. Щёлкните мышкой по входному проводнику, затем щёлкните по значку Edge Port на 
панели инструментов и установите порт на входе фильтра. Щёлкните мышкой по порту 
и сдвиньте референсную плоскость на 1 мм вправо. 

10. Аналогично установите порт на выходе фильтра, сдвинув его референсную плоскость 
на 1 мм влево. Созданная электромагнитная структура должна выглядеть, как показано 
на рис. 4.41. 

Рис 4 41
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Сделайте активным окно графика 
и щёлкните мышкой по значку Analyze 
на панели инструментов. Полученная 
характеристика показана на рис. 4.42. 
Она несколько сдвинута вверх по часто-
те. При необходимости можно отредак-
тировать электромагнитную структуру, 
увеличив длину резонаторов. Можно 
также несколько сузить полосу пропус-
кания, увеличив величину зазоров. Или 
оставить без изменения для обеспечения 
запаса по частоте для настройки и по 
ширине полосы пропускания с учётом 
технологических разбросов. Рис. 4.42 

 

4.3. Фильтр с боковыми электромагнитными связями с полосой пропуска-
ния 11-14 ГГц 

Загрузите Microwave Office, установите глобальные единицы измерения для частоты 
GHz и отметьте метрическую систему единиц Metric units. Загрузите Nuhertz Filter Wizard, 
чтобы открыть окно Filter Synthesis. 

На вкладке Topology: 
1. В поле Implementation (Реализация) введите Microstrip. 
2. В поле Shape (Вид) введите Chebyshev I. 
3. В поле Type введите Band Pass. 

На вкладке Settings: 
1. В поле Order (Порядок) введите 5. 
2. В поле Pass Band Def (Определение полосы пропускания) введите Corner Freqs. 
3. В поле Lower Corner Frequency введите 11 GHz. 
4. В поле Upper Corner Frequency введите 14 GHz. 
5. Отметьте Standard Pass Band Attenuation. 
6. В поле Pass Band Ripple (dB) введите величину пульсаций в полосе пропускания 0.05. 
7. В поле Conductor Thickness (Толщина проводника) введите 0.005 mm. 
8. В поле Dielectric Height (Толщина диэлектрика) введите 0.5. 
9. В поле Dielectric Loss Tangent введите тангенс диэлектрических потерь 0.0001. 

На вкладке Defaults: 
1. В полях Source Resistance (Сопротивление источника) и Load Resistance (Сопротив-
ление нагрузки) введите 50 Ohm. 

2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемость 10.63. 
3. В поле Frequency Where Aliasing Begins введите 18 GHz. 
4. Отметьте Coupled Resonator Filter и в поле Coupled Res Filter Type введите Parallel 

Coupled Open Resonators, щёлкнув по кнопке в правом конце этого поля. 
5. Отметьте Coupled Resonator Internal Impedance и в поле Center Resonator Imped-

ance введите 50 Ohm. 
6. Значения остальных полей оставьте по умолчанию. 

На вкладке Schematic: 
1. В поле Schematic Name введите имя схемы Fil11. 
2. В области Schematic Generation отметьте Append. 
3. Отметьте Include Optimization Goals (Включить цели оптимизации). 
4. Отметьте Generate Graphs (Создать графики). 
5. В области Graphs To Generate отметьте Rectangular (Прямоугольный) и снимите от-
метки для всех остальных типов графиков. 

6. В области Measurement for Rectangular отметьте Forward Transfer dB(S21). 
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7. В области Graph Limits отметьте Sent To MWO, в поле Min Freq введите 10 GHz, в 
поле Max Freq введите 15 GHz. 
После ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 

основное окно панели управления Nuhertz Filter (рис. 4.43), в котором определены все ранее 
сделанные установки. В строке меню этого окна выберите File>Save As и сохраните синте-
зируемый фильтр в файле Fil11. 

Щёлкните мышкой по кнопке Circuits в нижнем правом углу открывшегося окна па-
нели управ-
ления. Син-
тезирован-

ная схема 
фильтра по-
казана на 
рис. 4.44. 
Ширина за-
зора в край-
них связан-
ных отрез-
ках линий 
получилась 

равной 
0.05966 мм. 
Чтобы из-
бежать та-
кого зазо-
ра, отметь-
те в окне 
синтезиро-

ванной 
схемы 

Pinned. 
Схема бу-
дет преоб-
разована к 
виду, пока-
занному на 
рис. 4.45. 

Рис. 4.43

Рис. 4.44

 
Рис. 4.45  
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Щёлкните мышкой по кнопке Freq 
в верхнем правом углу окна схемы. Рас-
считанная Nuhertz Filter характеристика 
показана на рис. 4.46. 

Чтобы передать синтезированную 
схему фильтра в Microwave Office, щёлк-
ните мышкой по кнопке MWO в левом 
верхнем углу окна схемы рис. 4.45. От-
кроется окно установки опций для пере-
дачи схемы в Microwave Office рис. 4.47. 

В поле Schematic Name введите 
имя схемы Fil11. 

Отметьте Simulate After Export, 
чтобы сразу после передачи был выпол-
нен анализ схемы, и Include Optimization 

Goals, чтобы доба-
вить цели оптимиза-
ции. 

Рис. 4.46 

Рис. 4.47

Отметьте тип 
графика Rectangular 
и уберите отметки во 
всех остальных типах 
графиков. 

Отметьте 
Forward Transfer 
(S21) и снимите от-
метки у всех осталь-
ных единиц измере-
ния. 

Щёлкните 
мышкой по кнопке 
Append to MWO в 
правом нижнем углу 
окна. На рис. 4.48 по-
казаны переданная 
схема и рассчитанная 
в Microwave Office Рис. 4.48 
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характеристика. 
Определим частоты проекта. Дважды щёлкните мышкой по Project Options в левом 

окне проекта. В открывшемся окне опций на вкладке Frequencies в поле Start (GHz) введите 
10, в поле Stop (GHz) введите 15, в поле Step (GHz) введите 0.2, отметьте Replace, нажмите 
Apply и OK. 

Щёлкните правой кнопкой мышки по имени схемы Fil11 в левом окне проекта и вы-
берите Options. На вкладке Frequencies открывшегося окна отметьте Use project defaults и 
нажмите OK. 

Щёлкните правой кнопкой мышки по имени измеряемой величины Fil11:DB(|S(2,1)|) 
в графике в левом окне проекта и выберите Properties. В поле Data Source Name введите All 
Sources, чтобы на одном графике можно было отобразить характеристики и схемы, и элек-
тромагнитной структуры, нажмите OK. Щёлкните мышкой по значку Analyze на панели ин-
струментов. 

Сделайте активным окно графика. 
Щёлкните по графику правой кнопкой 
мышки и выберите Properties. На вкладе 
Axes окна свойств графика  для оси x сни-
мите “галочку” в Auto divs и в поле Step 
введите 0.5. Для оси Left 1 снимите “га-
лочки” в Auto limits и в Auto divs. В поле 
Min введите -30, в поле Max введите 0, в 
поле Step введите 5, нажмите Apply и OK. 

Теперь выполните оптимизацию. 
Выберите в меню Simulate>Optimize. В 
поле Optimization Methods введите метод 
оптимизации Pointer – Robust Optimiza-
tion, щёлкнув по кнопке в правом конце 
этого поля, в поле Maximum Iteration вве-

дите 500, нажмите Start. Полученный график показан на 
рис. 4.49. Значения переменных получили значения, кото-
рые показаны на рис. 4.50. 

Рис. 4.49

Сделайте активным окно схемы и округлите значе-
ния переменных до пяти сотых, как показано на рис. 4.51, 
дважды щёлкая левой мышки по переменным. 

Рис. 4.50 

Сделайте активным окно графика и щёлкните мыш-
кой по значку Analyze на панели инструментов, чтобы 

убедиться, что характеристика почти не изменилась. 
Рис. 4.51 

Добавим 50-омные отрезки на входе и выходе фильтра. Сделайте активным окно схе-
мы. Установите курсор на входной порт, нажмите клавишу Ctrl и левую кнопку мышки. Пе-
реместите входной порт на свободное место в окне схемы, прервав связь порта со схемой. 
Аналогично сместите выходной порт. Откройте окно просмотра элементов в левом окне про-
екта и раскройте группу Microstrip. Щёлкните мышкой по подгруппе Lines, перетащите 
элемент MLIN в окно схемы и соедините его со входом схемы. Дважды щёлкните по добав-
ленному элементу MLIN. В открывшемся окне свойств элемента введите значения W=0.45 и 

Рис. 4.52 
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L=3. Щёлкните мышкой по значку Copy и затем по значку Paste на панели инструментов 
(элемент MLIN должен быть выделен) и подключите скопированный элемент к выходу схе-
мы. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите порт 
ко входу схемы. Аналогично подключите выходной порт к выходу схемы. Схема должна 
иметь вид, показанный на рис. 4.52. 

Откройте окно просмотра проекта Project в левом окне, сделайте активным окно гра-
фика и щёлкните мышкой по значку Analyze на панели инструментов, чтобы убедиться, что 
характеристика схемы практически не изменилась. 

Сделайте активным окно схемы и щёлкните мышкой по значку New Schematic Layout 
View на панели инструментов, чтобы создать топологию схемы. Выберите в меню 
Edit>Select All, чтобы выделить всю топологию. Щёлкните по значку Snap Together на па-
нели инструментов, чтобы упорядочить созданную топологию. В поле Grid Spacing введите 

0.5, чтобы размер сетки сделать 0.05 мм. 
Созданная топология показана на рис. 4.53. 

Рис. 4.53 
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Выберите в меню Options>Layout 
Options. В открывшемся окне опций топо-
логии рис. 4.54 на вкладке Dimension Lines 
в поле Font height введите 0.3, в поле Arrow 
size введите 0.2 и в поле Precision введите 2, 
нажмите OK.  

Щёлкая по значку Dimension Line на 
панели инструментов, измерьте размеры 
созданной топологии, как показано на рис. 
4.53. Используя View Area, убедитесь, что 
расположение элементов топологии совпа-
дает с сеткой. В противном случае отредак-
тируйте расположение топологии. 

Теперь создадим электромагнитную 
структуру. 

Рис. 4.54 

1. Щёлкните по значку New EM Structure на панели инструментов, создайте структуру с 
именем F11 и отметьте AWR EMSight Simulator. 

2. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне свойств структуры на вкладке Enclosure введите X_Dim=18.3 mm, Y_Dim=6 mm, 
Grid_X=0.05 mm и Grid_Y=0.05 mm. 

3. На вкладке Material defs введите Er=10.63 и TanD=0.0001. 
4. На вкладке Dielectric Layers для слоя 1 введите толщину 6 мм и для слоя 2 – толщину 

0.5 мм. 
5. На вкладке Materials отметьте 1/2oz Cu. Нажмите OK. 
6. Сделайте активным окно топологии схемы и выделите всю топологию. Щёлкните по 
значку Copy на панели инструментов. 

7. Сделайте активным окно электромагнитной структуры и щёлкните по значку Paste на 
панели инструментов. Вставьте скопированную топологию в корпус так, чтобы левый и 
правый края входного и выходного проводников точно совпадали с левым и правым 
краями корпуса соответственно. 



8. Выделите всю топологию, щёлкните по любому элементу топологии правой кнопкой 
мышки и выберите Shape Properties. В открывшемся окне в поле Material введите 
1/2oz Cu. 

9. Щёлкните мышкой по входному проводнику, затем щёлкните по значку Edge Port на 
панели инструментов и установите порт на входе фильтра. Щёлкните мышкой по порту 
и сдвиньте его референсную плоскость на 1 мм вправо. 

10. Аналогично установите порт на выходе фильтра, сдвинув его референсную плоскость 
на 1 мм влево. Созданная электромагнитная структура должна выглядеть, как показано 
на рис. 4.55. 

Сделайте активным окно графика и щёлкните мышкой по значку Analyze на панели 
инструментов. Полученная характеристика показана на рис. 4.56. Сделайте активным окно 
электромагнитной структуры и отредактируйте топологию, увеличив длину всех отрезков 
линий на 0.05 мм. Снова выполните анализ. Характеристика отредактированной структуры 
показана на рис.4.57. 

Рис. 4.55

Рис. 4.57 Рис. 4.56

4.4. Встречноштыревой фильтр с полосой пропускания 3-3.6 ГГц 
Загрузите Microwave Office, установите глобальные единицы измерения для частоты 

GHz и отметьте метрическую систему единиц Metric units. Загрузите Nuhertz Filter Wizard, 
чтобы открыть окно Filter Synthesis. 

На вкладке Topology: 
1. В поле Implementation (Реализация) введите Microstrip. 
2. В поле Shape (Вид) введите Chebyshev I. 
3. В поле Type введите Band Pass. 

На вкладке Settings: 
1. В поле Order (Порядок) введите 5. 
2. В поле Pass Band Def (Определение полосы пропускания) введите Corner Freqs. 
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3. В поле Lower Corner Frequency введите 3 GHz. 
4. В поле Upper Corner Frequency введите 3.6 GHz. 
5. Отметьте Standard Pass Band Attenuation. 
6. В поле Pass Band Ripple (dB) введите величину пульсаций в полосе пропускания 0.05. 
7. В поле Conductor Thickness (Толщина проводника) введите 0.005 mm. 
8. В поле Dielectric Height (Толщина диэлектрика) введите 1. 
9. В поле Dielectric Loss Tangent введите тангенс диэлектрических потерь 0.0001. 

На вкладке Defaults: 
1. В полях Source Resistance (Сопротивление источника) и Load Resistance (Сопротив-
ление нагрузки) введите 50 Ohm. 

2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемость 10.28. 
3. В поле Frequency Where Aliasing Begins введите 18 GHz. 
4. Отметьте Coupled Resonator Filter и в поле Coupled Res Filter Type введите Inter-

digital Tapped, щёлкнув по кнопке в правом конце этого поля. 
5. Отметьте Coupled Resonator Internal Impedance и в поле Center Resonator Imped-

ance введите 50 Ohm. 
6. Значения остальных полей оставьте по умолчанию. 

На вкладке Schematic: 
1. В поле Schematic Name введите имя схемы Fil3. 
2. В области Schematic Generation отметьте Append. 
3. Отметьте Include Optimization Goals (Включить цели оптимизации). 
4. Отметьте Generate Graphs (Создать графики). 
5. В области Graphs To Generate отметьте Rectangular и снимите отметки для всех ос-
тальных типов графиков. 

6. В области Measurement for Rectangular отметьте Forward Transfer dB(S21). 
7. В области Graph Limits отметьте Sent To MWO, в поле Min Freq введите 2 GHz, в 
поле Max Freq введите 5 GHz. 
После ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 

основное окно панели управления Nuhertz Filter (рис. 4.58), в котором определены все ранее 
сделанные установки. В строке меню этого окна выберите File>Save As и сохраните синте-
зируемый фильтр в файле Fil3. 

В правом нижнем углу окна панели управления снимите  отметку  1 st Ser,  отметьте  
1 st Shu и Use Coupled Lines. Затем щёлкните мышкой по кнопке Circuits. В открывшемся 
окне схемы отметьте Interdigital и Tapped. Синтезированная схема показана на рис. 4.59. 

Щёлкните мышкой по кнопке Freq в верхнем правом углу окна схемы. Рассчитанная 
Nuhertz Filter характеристика показана на рис. 4.60. 

Рис. 4.58 
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Рис. 4.59

Рис. 4.60

Чтобы передать синтезированную схему 
фильтра в Microwave Office, щёлкните мышкой по 
кнопке MWO в левом верхнем углу окна схемы рис. 
4.59. Откроется окно установки опций для передачи схемы в Microwave Office рис. 4.61. 

В поле Schematic 
Name введите имя схемы 
Fil3. 

Отметьте Simulate 
After Export, чтобы сразу 
после передачи был вы-
полнен анализ схемы, и 
Include Optimization 
Goals, чтобы добавить 
цели оптимизации. 

Отметьте тип гра-
фика Rectangular и убе-
рите отметки во всех ос-
тальных типах графиков. 

Отметьте Forward 
Transfer (S21) и снимите 
отметки у всех остальных 
единиц измерения. 

Щёлкните мышкой 
по кнопке Append to 
MWO в правом нижнем 

Рис. 4.61
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углу окна. На рис. 4.62 показаны переданная схема и рассчитанная в Microwave Office харак-
теристика. 

Добавьте 50-омные отрезки на входе и выходе схемы. Сделайте активным окно схе-
мы. Установите курсор на входной порт, нажмите клавишу Ctrl и левую кнопку мышки. Пе-
реместите входной порт на свободное место в окне схемы, прервав связь порта со схемой. 
Аналогично сместите выходной порт. Откройте окно просмотра элементов в левом окне про-
екта и раскройте группу Microstrip. Щёлкните мышкой по подгруппе Lines, перетащите 
элемент MLIN в окно схемы и соедините его со входом схемы. Дважды щёлкните по добав-
ленному элементу MLIN. В открывшемся окне свойств элемента введите значения W=0.9 и 
L=3. Щёлкните мышкой по значку Copy и затем по значку Paste на панели инструментов 
(элемент MLIN должен быть выделен) и подключите скопированный элемент к выходу схе-
мы. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите порт 
ко входу схемы. Аналогично подключите выходной порт к выходу схемы. 

Щёлкните мышкой по значку New Schematic Layout View на панели инструментов, 
чтобы создать топологию схемы. Выберите в меню Edit>Select All, чтобы выделить всю то-
пологию. Щёлкните по значку Snap Together на панели инструментов, чтобы упорядочить 
созданную топологию. В поле Grid Spacing введите 0.5, чтобы размер сетки сделать 0.05 мм. 

Выберите в меню Simulate>Optimize, чтобы выполнить оптимизацию схемы. В от-
крывшемся окне Optimizer в поле Optimization Methods введите Pointer – Robust Optimi-
zation, в поле Maximum Iteration введите 5000. Выберите в меню Window>Tile Horizontal, 
чтобы наблюдать, как изменяются график, схема и топология в процессе оптимизации (рис. 
4.63). Щёлкните мышкой по кнопке Start в окне Optimizer. 

Рис. 4.63 
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Полученная после оптимизации характеристика показана на рис. 4.64. Неравномерность в 
полосе пропускания можно уменьшить, используя блок настройки. Для этого сделайте ак-
тивным окно графика. Щёлкните левой кнопкой мышки по значку Tune на панели инстру-
ментов и, двигая движки переменных, добейтесь более равномерной характеристики в поло-
се пропускания. График после ручной подстройки показан на рис. 4.65. 

Переменные после настройки получили значения, показанные на рис. 4.66. Сделайте 
активным окно схемы и круглите значения переменных до пяти сотых, как показано на рис. 
4.67. 

Рис. 4.64 Рис. 4.65 
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Сделайте активным окно топо-
логии схемы. Выделите всю тополо-
гию и щёлкните мышкой по значку 
Snap Together на панели инструмен-
тов, чтобы упорядочить топологию. 
Созданная топология схемы показана 
на рис. 4.68. 

Рис. 4.67 Рис. 4.66 

Создайте электромагнитную 
структуру. 

1. Щёлкните по значку New EM 
Structure на панели инструмен-
тов, создайте структуру с име-
нем F3 и отметьте AWR EM-
Sight Simulator. 

2. Щёлкните по значку Substrate 
Information на панели инстру-

ментов. В открывшемся окне свойств структуры на вкладке Enclosure введите 
X_Dim=15.1 mm, Y_Dim=10 mm, Grid_X=0.05 mm и Grid_Y=0.05 mm. 

Рис. 4.68 

3. На вкладке Material defs введите Er=10.28 и TanD=0.0001. 
4. На вкладке Dielectric Layers для слоя 1 введите толщину 6 мм и для слоя 2 – толщину 

1 мм. 
5. На вкладке Materials отметьте 1/2oz Cu. Нажмите OK. 
6. Сделайте активным окно топологии схемы и выделите всю топологию. Щёлкните по 
значку Copy на панели инструментов. 

7. Сделайте активным окно электромагнитной структуры и щёлкните по значку Paste на 
панели инструментов. Вставьте скопированную топологию в корпус так, чтобы левый и 



правый края входного и выходного проводников точно совпадали с левым и правым 
краями корпуса соответственно. 

8. Выделите всю топологию, щёлкните по любому элементу топологии правой кнопкой 
мышки и выберите Shape Properties. В открывшемся окне в поле Material введите 
1/2oz Cu. 

9. Создайте межслойные перемычки для заземления резонаторов. Откройте окно менед-
жера топологии, щёлкнув мышкой по кнопке Layout в левой нижней части окна. От-
метьте Via, в поле Material введите 1/2oz Cu, в поле Extent введите 1. 

10. Щёлкните мышкой по значку Via Port на панели инструментов. 
Поместите курсор в нижней части первого резонатора, нажмите 
левую кнопку мышки, переместите курсор на 0.2 вправо и на 0.4 
вниз, отпустите кнопку. Должна образоваться прямоугольная пе-
ремычка (рис. 4.69), которая будет выделена. 

11. Щёлкните по значку Copy и затем по значку Paste на панели ин-
струментов. Щёлкните правой кнопкой мышки, чтобы развернуть 
скопированную перемычку, и поместите её, как показано на рис. 
4.70. 

Рис. 4.69 

12. Выберите в меню Draw>Modify Shapes>Union (Рисовать> Мо-
дифицировать формы>Объединить), чтобы объединить созданные 
перемычки в одну. 

Рис. 4.70 13. При выделенной перемычке щёлкните по значку Copy на панели 
инструментов. Затем, щёлкая по 
значку Paste на панели инстру-
ментов, установите перемычки на 
соответствующие концы осталь-
ных резонаторов. 
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14. Щёлкните мышкой по входному 
проводнику, затем щёлкните по 
значку Edge Port на панели инст-
рументов и установите порт на 
входе фильтра. Щёлкните мыш-
кой по порту и сдвиньте рефе-
ренсную плоскость на 1 мм впра-
во. 

15. Аналогично установите порт на 
выходе фильтра, сдвинув его ре-

ференсную плоскость на 1 мм влево. Созданная электромагнитная структура должна 
выглядеть, как показано на рис. 4.71. 

Рис. 4.71 

16. Откройте окно просмотра проекта, щёлкнув мышкой по кнопке Project в левой ниж-
ней части окна. 

17. Дважды щёлкните левой кнопкой мышки по Project Options и в открывшемся окне 
опций проекта на вкладке Frequencies в поле Start(GHz) введите 2, в поле Stop(GHz) 
введите 5, в поле Step(GHz) введите 0.2. Нажмите Apply. Отметьте Add и Single point. 
В поле Point(GHz) введите 2.9, нажмите Apply. Затем в это поле введите 3.7, нажмите 
Apply и OK. 

18. Щёлкните правой кнопкой мышки по имени схемы Fil3 в окне просмотра проекта и 
выберите Options. В открывшемся окне опций схемы на вкладке Frequencies отметьте 
Use project defaults и нажмите OK. 

19. Щёлкните правой кнопкой мышки по имени измеряемой величины Fil3:DB(|S(2,1)|) в 
окне просмотра проекта и выберите Properties. В открывшемся окне свойств в поле 
Data Source Name введите All Sources, нажмите OK. 

20. Сделайте активным окно графика. Щёлкните по графику правой копкой мышки и вы-
берите Properties. В открывшемся окне свойств графика на вкладке Axes для оси x сни-
мите отметку в Auto divs и в поле Step введите 0.2. Для оси Left 1 снимите отметки в 



Auto limits и в Auto divs. В поле 
Min введите -60, в поле Max введите 
0 и в поле Step введите 5. Нажмите 
Apply и OK. 

21. Щёлкните по значку Analyze на 
панели инструментов. Рассчитанный 
график показан на рис. 4.72. Харак-
теристика электромагнитной струк-
туры получилась несколько уже ха-
рактеристики схемы. 
Чтобы расширить полосу пропус-

кания, нужно уменьшить зазоры между 
вторым и третьим резонаторами, и между 
третьим и четвёртым резонаторами. Для 
этого установите курсор левее и выше 

электромагнитной структуры, нажмите левую 
кнопку мышки и переместите курсор правее и 
ниже второго резонатора, чтобы выделить 
входной проводник и два первых резонатора 
(рис. 4.73). Установите курсор на любой выде-
ленный проводник, нажмите левую кнопку 
мышки и сместите выделенные проводники на 
0.15 мм вправо. 

Аналогично сместите выходной про-
водник и два последних резонатора на 0.15 мм 
влево. 

Дважды щёлкните по входному про-
воднику, установите курсор на ромбик посе-
редине левого края проводника и сместите 
его влево на 0.15 мм до границы корпуса. 
Аналогично сместите правый край выходно-
го проводника до правой границы корпуса. 

Щёлкните по значку Analyze на пане-
ли инструментов. Характеристика отредакти-
рованной электромагнитной структуры пока-
зана на рис. 4.74. 

Рис. 4.72

Рис. 4.73 

 
 
 

Рис. 4.74  

4.5. Шпилечный фильтр с полосой пропускания 2-2.3 ГГц 
Загрузите Microwave Office, установите глобальные единицы измерения для частоты 

GHz и отметьте метрическую систему единиц Metric units. Загрузите Nuhertz Filter Wizard, 
чтобы открыть окно Filter Synthesis. 

На вкладке Topology: 
1. В поле Implementation (Реализация) введите Microstrip. 
2. В поле Shape (Вид) введите Chebyshev I. 
3. В поле Type введите Band Pass. 

На вкладке Settings: 
1. В поле Order (Порядок) введите 5. 
2. В поле Pass Band Def (Определение полосы пропускания) введите Corner Freqs. 
3. В поле Lower Corner Frequency введите 2 GHz. 
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4. В поле Upper Corner Frequency введите 2.3 GHz. 
5. Отметьте Standard Pass Band Attenuation. 
6. В поле Pass Band Ripple (dB) введите величину пульсаций в полосе пропускания 0.05. 
7. В поле Conductor Thickness (Толщина проводника) введите 0.005 mm. 
8. В поле Dielectric Height (Толщина диэлектрика) введите 1. 
9. В поле Dielectric Loss Tangent введите тангенс диэлектрических потерь 0.0001. 

На вкладке Defaults: 
1. В полях Source Resistance (Сопротивление источника) и Load Resistance (Сопротив-
ление нагрузки) введите 50 Ohm. 

2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемость 10.26. 
3. В поле Frequency Where Aliasing Begins введите 10 GHz. 
4. Отметьте Coupled Resonator Filter и в поле Coupled Res Filter Type введите Hairpin 

Tapped, щёлкнув по кнопке в правом конце этого поля. 
5. Отметьте Coupled Resonator Internal Impedance и в поле Center Resonator Imped-

ance введите 50 Ohm. 
6. Значения остальных полей оставьте по умолчанию. 

На вкладке Schematic: 
1. В поле Schematic Name введите имя схемы Fil2. 
2. В области Schematic Generation отметьте Append. 
3. Отметьте Include Optimization Goals (Включить цели оптимизации). 
4. Отметьте Generate Graphs (Создать графики). 
5. В области Graphs To Generate отметьте Rectangular и снимите отметки для всех ос-
тальных типов графиков. 

6. В области Measurement for Rectangular отметьте Forward Transfer dB(S21). 
7. В области Graph Limits отметьте Sent To MWO, в поле Min Freq введите 2 GHz, в 
поле Max Freq введите 5 GHz. 
После ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 

основное окно панели управления Nuhertz Filter (рис. 4.75). В правом нижнем углу окна па-
нели управления снимите отметку 1 st Ser, отметьте 1 st Shu, Combine Stubs и Use Coupled 
Lines.  

В строке меню окна панели управления выберите File>Save As и сохраните синтези-
руемый фильтр в файле Fil2. 

Щёлкните мышкой по кнопке Circuits в правом нижнем углу окна панели управления. 
Синтезированная схема показана на рис. 4.76. В открывшемся окне схемы отметьте Hairpin 
в правом верхнем углу и щёлкните мышкой по кнопке Freq в левом верхнем углу. Рассчи-
танная Nuhertz Filter характеристика показана на рис. 4.77. 

Рис. 4.75
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Рис. 4.76

 
Чтобы передать синтезиро-

ванную схему фильтра в Microwave 
Office, щёлкните мышкой по кноп-
ке MWO в левом верхнем углу ок-
на схемы рис. 4.76. Откроется окно 
установки опций дл  передачи схе-
мы в Microwave Office рис. 4.78. В 
этом окне введите следующие па-
раметры: 
 
 
 
 
 

Рис. 4.77  

1. В поле Schematic Name введите имя схемы Fil2. 
Рис. 4.78

2. Отметьте Simulate After Export, чтобы сразу после передачи был выполнен анализ 
схемы, и Include Optimization Goals, чтобы добавить цели оптимизации. 

3. Отметьте тип графика Rectangular и уберите отметки во всех остальных типах графи-
ков. 

4. Отметьте Forward Transfer (S21) и снимите отметки у всех остальных единиц изме-
рения. 



5. Щёлкните мышкой по кнопке Append to MWO в правом нижнем углу окна. 
Переданная в Microwave Office схема показана на рис. 4.79. 

Добавьте на входе и выходе схемы 50-омные отрезки линий. Для этого: 
Рис. 4.79 

1. Нажмите клавишу Ctrl, установите курсор на входной порт, нажмите левую кнопку 
мышки и переместите порт на свободное место в окне схемы, прервав связь порта со 
схемой. Аналогично переместите выходной порт. 

2. Щёлкните левой кнопкой мышки по элементу изгиба MBEND90X$ ID=MS2 в верхней 
части схемы, чтобы выделить его. Щёлкните мышкой по значку Copy и затем по значку 
Paste на панели инструментов. Подключите скопированный элемент изгиба ко входу 
схемы, дважды щёлкните по нему и введите W=W1, нажмите OK. 

3. Щёлкните левой кнопкой мышки по элементу изгиба MBEND90X$ ID=MS5 в верхней 
части схемы, чтобы выделить его. Щёлкните мышкой по значку Copy и затем по значку 
Paste на панели инструментов. Подключите скопированный элемент изгиба к выходу 
схемы, дважды щёлкните по нему и введите W=W1, нажмите OK. 

4. Щёлкните левой кнопкой мышки по элементу отрезка линии MLIN ID=MS2, чтобы 
выделить его. 

5. Щёлкните мышкой по значку Copy и затем по значку Paste на панели инструментов. 
Подключите скопированный элемент MLIN ко входу схемы. Дважды щёлкните мыш-
кой по этому элементу и введите W=1 и L=3. 

6. Снова щёлкните по значку Paste на панели инструментов и подключите скопирован-
ный элемент MLIN к выходу схемы. Дважды щёлкните мышкой по этому элементу и 
введите W=1 и L=3. 

7. Установите курсор на входной порт, нажмите левую кнопку мышки и подключите 
порт ко входу схемы. 

8. Установите курсор на выходной порт, нажмите левую кнопку мышки и подключите 
порт к выходу схемы. 
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Схема будет иметь вид, показанный на рис. 4.80. 

Сделайте активным окно графика и щёлкните мышкой по значку Analyze на панели 
инструментов. Рассчитанная в Microwave Office характеристика показана на рис. 4.81. 

Выполните оптимизацию схемы. Для это-
го выберите в меню Simulate Optimize. В от-
крывшемся окне выберите метод оптимизации 
Pointer-Robust Optimization, введите количество 
итераций 500 и нажмите Start. Характеристика 
после оптимизации показана на рис. 4.82. Вы-
полненная оптимизация не дала ожидаемого ре-
зультата. Можно попробовать другие методы оп-
тимизации. Мы выполним подстройку схемы 
вручную. Обратите внимание, что для настройки 
назначены все переменные и длина связанных 
линий L в элементе M12CLIN. 

Щёлкните по значку Tune на панели ин-
струментов и, двигая движки переменных, до-

бейтесь требуемой характеристики. Характеристика после настройки показана на рис. 4.83. 

Рис. 4.80

Рис. 4.82Рис. 4.81

Рис. 4.81



Переменные при этом получили значения, показанные на рис. 4.84, 
длина связанных линий L=11.71. 

Округлите эти значения до оной десятой, как показано на 
рис. 4.85. Для этого сделайте активным окно схемы, дважды щёлк-

ните мышкой, например, по переменной W2=0.995, исправьте её 
значение на W2=1 и щёлкните мышкой вне значения этой пере-
менной. Аналогично исправьте значения всех остальных перемен-
ных. Дважды щёлкните по элементу связанных линий M12CLIN и 
введите L=11.7. 

Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов, чтобы убедиться, что характеристика изменилась не существенно. 

Создайте топологию схемы: 

Рис. 4.84

Рис. 4.85 

1. Выберите в меню Options>Layout Options. На вкладке Dimension Lines в поле Font 
height введите 0.6, в поле Arrow size введите 0.5, в поле Precision введите 2, нажмите 
OK. 

2. Сделайте активным окно схемы и щёлкните по значку New Schematic Layout View. 
3. В поле Grid Spacing на панели инструментов введите множитель 1х, чтобы сделать 
размер ячеек сетки 0.1 мм. 

4. Выберите в меню Edit>Select All, чтобы выделить всю топологию. 
5. Щёлкните по значку Snap Together на панели инструментов, чтобы упорядочить то-
пологию. 

6. Щёлкая по значку Dimension Line на панели инструментов, измерьте длину и ширину 
топологии. 
Созданная топология схемы показана на рис. 4.86. 

Создайте электромагнитную структуру: 
Рис. 4.86

1. Щёлкните по значку New EM Structure на панели инструментов. В открывшемся окне 
введите имя структуры F2, отметьте решающее устройство AWR EMSight Simulator и 
нажмите Create. 

2. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне свойств структуры на вкладке Enclosure введите X_Dim=30.9 mm, Y_Dim=16 
mm, Grid_X=0.1 mm и Grid_Y=0.1 mm. 

3. На вкладке Material defs введите Er=10.26 и TanD=0.0001. 
4. На вкладке Dielectric Layers для слоя 1 введите толщину 6 мм и для слоя 2 – толщину 

1 мм. 
5. Нажмите OK. 
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6. Сделайте активным окно топологии схемы и выделите всю топологию. Щёлкните по 
значку Copy на панели инструментов. 

7. Сделайте активным окно электромагнитной структуры и щёлкните по значку Paste на 
панели инструментов. Вставьте скопированную топологию в корпус так, чтобы левый и 
правый края входного и выходного проводников точно совпадали с левым и правым 
краями корпуса соответственно. 

8. Выделите всю топологию, щёлкните по любому элементу топологии правой кнопкой 
мышки и выберите Shape Properties. В открывшемся окне в поле Material введите 

1/2oz Cu. 
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9. Щёлкните по значку View Area на панели инст-
рументов и увеличьте входной проводник, чтобы 
удобнее было его отредактировать (рис. 4.87). 

10. Установите курсор на входной проводник, на-
жмите левую кнопку мышки и переместите вход-
ной проводник на 0.2 мм вниз. Щёлкните мышкой 
по уголку, чтобы выделить его, и нажмите клави-
шу Delete, чтобы удалить уголок. Щёлкните по 
значку Polygon на панели инструментов, устано-
вите курсор на правый нижний угол первого вер-
тикального проводника, щёлкните мышкой, 
сдвиньте курсор влево до левого нижнего угла 
первого вертикального проводника, щёлкните 
мышкой, сдвиньте курсор вниз до нижней границы 
горизонтального проводника и дважды щёлкните 
мышкой. Щёлкните по созданному уголку левой 

кнопкой мышки, затем правой кнопкой, выберите Shape Properties и определите мате-
риал 1/2oz Cu. Соединение проводников будет выглядеть, как показано на рис. 4.88. 

Рис. 4.87 

Рис. 4.88 

11. Аналогично отредактируйте выходной проводник. Топология будет выглядеть, как 
показано на рис. 4.89. 

12. Создайте межслойные перемычки для заземления резонаторов. Откройте окно менед-
жера топологии, щёлкнув мышкой по кнопке Layout в левой нижней части окна. От-
метьте Via, в поле Material введите 1/2oz Cu, в поле Extent введите 1. 

Рис. 4.89

13. Щёлкните мышкой по значку Via Port на панели инструментов. Поместите курсор в 
верхней части входного проводника связи, нажмите левую кнопку мышки, переместите 



курсор на 0.1 вправо и на 0.3 вниз, отпустите кнопку. Должна об-
разоваться прямоугольная перемычка, которая будет выделена. 

14. Щёлкните по значку Copy и затем по значку Paste на панели 
инструментов. Щёлкните правой кнопкой мышки, чтобы развер-
нуть скопированную перемычку, и поместите её, как показано на 
рис. 4.90. 

15. Выберите в меню Draw>Modify Shapes>Union (Рисовать> Мо-
дифицировать формы>Объединить), чтобы объединить создан-
ные перемычки в одну. Рис. 4.90 

16. При выделенной перемычке щёлкните по значку Copy на панели инструментов. Затем, 
щёлкая по значку Paste на панели инструментов, установите перемычки на соответст-
вующие концы всех шпилек и выходного проводника связи. 

17. Щёлкните мышкой по входному проводнику, затем щёлкните по значку Edge Port на 
панели инструментов и установите порт на входе фильтра. Щёлкните мышкой по порту 
и сдвиньте референсную плоскость на 2 мм вправо. 

18. Аналогично установите порт на выходе фильтра, сдвинув его референсную плоскость 
на 2 мм влево. Созданная электромагнитная структура должна выглядеть, как показано 
на рис. 4.91. 

19. Откройте окно просмотра проекта, щёлкнув мышкой по кнопке Project в левой ниж-
ней части окна. 

Рис. 4.91

20. Дважды щёлкните левой кнопкой мышки по Project Options и в открывшемся окне 
опций проекта на вкладке Frequencies в поле Start(GHz) введите 1, в поле Stop(GHz) 
введите 3, в поле Step(GHz) введите 0.05. Нажмите Apply и OK. 

21. Щёлкните правой кнопкой мышки по имени схемы Fil2 в окне просмотра проекта и 
выберите Options. В открывшемся окне опций схемы на вкладке Frequencies отметьте 
Use project defaults и нажмите OK. 

22. Щёлкните правой кнопкой мышки по имени измеряемой величины Fil2:DB(|S(2,1)|) в 
окне просмотра проекта и выберите Properties. В открывшемся окне свойств в поле 
Data Source Name введите All Sources, нажмите OK. 

23. Сделайте активным окно графика. Щёлкните по значку Analyze на панели инструмен-
тов. Щёлкните по графику правой копкой мышки и выберите Properties. В открывшем-
ся окне свойств графика на вкладке Axes для оси x снимите отметку в Auto divs и в по-
ле Step введите 0.1. Для оси Left 1 снимите отметку в Auto divs и в поле Step введите 5. 
Нажмите Apply и OK. 
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Рассчитанный график показан на рис. 

4.92. Х актеристика электромагнитной струк-
туры получилась несколько уже характери-
стики схемы. 

Чтобы расширить полосу пропускания, 
нужно уменьшить зазоры между шпильками. 

1. Сделайте активным окно электромаг-
нитной структуры. 

2. Установите курсор левее и выше перво-
го проводника связи, нажмите левую 
кнопку мышки и переместите курсор 
правее и ниже второй шпильки, чтобы 
выделить две первых шпильки с вход-
ным проводником связи (рис. 4.93). Рис. 4.92

3. Установите курсор на любой выде-
ленный проводник, нажмите левую 
кнопку мышки и сдвиньте выделенную 
топологию на 0.3 мм вправо. 

Рис. 4.93

4. Затем аналогично выделите первую 
шпильку с входным проводником связи 
и сдвиньте их на 0.3 мм вправо. 

5. Таким же образом уменьшите осталь-
ные зазоры между шпильками, выделяя 
их и сдвигая на 0.3 мм влево. 

6. Дважды щёлкните по входному про-
воднику, установите курсор на ромбик 
посередине правой стороны проводни-
ка, нажмите левую кнопку мышки и 

сдвиньте эту сторону вправо до соединения с уголком. Аналогично удлините выходной 
проводник. 

Рис. 4.94 

7. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученный график показан на рис. 4.94. 
Характеристика электромагнитной структуры сдвинута вниз по частоте, поэтому 

нужно укоротить длину шпилек. 
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Выделите межслойную перемычку на первом проводнике связи и сдвиньте её на 0.3 
мм вниз. Дважды щёлкните по первому проводнику связи и сместите его верхнюю сторону 
на 0.3 мм вниз. 

На первой шпильке сдвиньте меж-
слойные перемычки на 0.3 мм вверх, сдвиньте 
нижнюю сторону обоих проводников шпиль-
ки вверх на 0.3 мм и затем сдвиньте всю 
шпильку на 0.3 мм вниз. 

На второй шпильке сдвиньте межслой-
ные перемычки на 0.3 мм вниз и сдвиньте 
верхнюю сторону обоих проводников шпиль-
ки вниз на 0.3 мм. 

Аналогично отредактируйте остальную 
топологию. 

Сделайте активным окно графика и 
щёлкните по значку Analyze на панели инст-
рументов. Характеристика показана на рис. 
4.95. Рис. 4.95 
 

 



5. Полосно-заграждающие фильтры 
В качестве примера рассмотрим проектирование фильтра, обеспечивающего ослабле-

ние не менее 50 дБ в диапазоне от 4.5 до 5.5 ГГц. Полоса пропускания должна быть обеспе-
чена от 0 до 3.5 ГГц и от 6.5 до 10 ГГц. 

Загрузите Microwave Office и выберите в меню Options>Project Options. В открыв-
шемся окне опций проекта на вкладке Global Units введите единицы измерения частоты 
GHz и отметьте Metric units. Нажмите OK. 

На вкладке Topology: 
1. В поле Implementation (Реализация) введите Microstrip. 
2. В поле Shape (Вид) введите Chebyshev I. 
3. В поле Type введите Band Stop. 

На вкладке Settings: 
1. В поле Order (Порядок) введите 7. 
2. В поле Pass Band Def (Определение полосы пропускания) введите Corner Freqs. 
3. В поле Lower Corner Frequency введите 4.5 GHz. 
4. В поле Upper Corner Frequency введите 5.5 GHz. 
5. Отметьте Standard Pass Band Attenuation. 
6. В поле Pass Band Ripple (dB) введите величину пульсаций в полосе пропускания 0.05. 
7. В поле Conductor Thickness (Толщина проводника) введите 0.005 mm. 
8. В поле Dielectric Height (Толщина диэлектрика) введите 0.5 mm. 
9. В поле Dielectric Loss Tangent введите тангенс диэлектрических потерь 0.0001. 

На вкладке Defaults: 
1. В полях Source Resistance (Сопротивление источника) и Load Resistance (Сопротив-
ление нагрузки) введите 50 Ohm. 

2. В поле Dielectric Constant (Er) введите диэлектрическую проницаемость 10.4. 
3. В поле Frequency Where Aliasing Begins введите 18 GHz. 
4. В поле First Element введите Shunt. 
5. Остальные значения оставьте по умолчанию. 

На вкладке Schematic: 
1. В поле Schematic Name введите имя схемы FilZ. 
2. Отметьте Generate Graphs (Создать графики) и Append (Добавить). 
3. В области Graphs To Generate отметьте Rectangular (Прямоугольный). 
4. В области Measurement for Rectangular отметьте Forward Transfer dB(S21). 
5. В области Graph Limits отметьте Sent To MWO, в поле Min Freq введите 0 GHz, в 
поле Max Freq введите 10 GHz. 
После ввода всех данных выберите в меню Integration>Nuhertz Interface. Откроется 

основное окно панели управления Nuhertz Filter (рис. 5.1). В строке меню этого окна выбе-
рите File>Save As и сохраните синтезируемый фильтр в файле FilZ. 
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Рис. 5.1
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Щёлкните мышкой 
по кнопке Circuits. От-
кроется окно со схемой 
(рис. 5.2). Ширина шлей-
фов на схеме помечена 
Invalid, т.е. они не реали-
зуемы. Если щёлкнуть по 
кнопке Freq в верхнем 
левом углу схемы, Nuhertz 
Filter выполнит анализ и 
отобразит график. Щёлк-
нув мышк й по кнопке 
MWO, можно передать 
схему в Microwave Office, 

на там анализ выполняться не будет (волновые сопротивле-
ния шлейфов в переданной схеме будут отрицательные). 
Чтобы анализ выполнялся и можно было настраивать схему, 
нужно будет изменить ширину шлейфов на реализуемое зна-
чение. Это можно сделать и в Nuhertz Filter, изменив волно-
вые сопротивления шлейфов. На схеме рис. 5.2 установите 
курсор на параметры первого шлейфа (параметры должны 
отображаться красным цветом) и щёлкните левой кнопкой 
мышки. Откроется диалоговое окно Modify Transmission 
Line Filter 1 (рис. 5.3). В поле Enter Segment Zo введите 50, 
нажмите Apply и OK. Аналогично отредактируйте волновые 
сопротивления всех остальных шлейфов. Схема будет вы-

глядеть, как показано на 
рис. 5.4. 

Щёлкните мыш-
кой по кнопке MWO в 
левом верхнем углу схе-
мы рис. 5.4, чтобы пере-
дать схему в Microwave 
Office. Откроется окно 
опций для передачи схе-
мы рис. 5.5. 

Рис. 5.2

Рис. 5.3 

1. В поле Schematic 
Name введите FilZ. 

2. Отметьте Simulate 
After Export. 

Рис. 5.4 



3. Отметьте тип графика Rectangular и снимите отметки у всех остальных типов графи-
ков. 

4. В области Rectangular Measurements отметьте Forward Transfer (S21). 
5. Щёлкните мышкой по кнопке Append to MWO в правом нижнем углу окна. 

Сделайте активной программу Microwave Office, щёлкнув мышкой по её окну или по 
её имени на панели задач Windows. 

Сделайте активным окно схемы и добавьте 50-омные отрезки линии на входе и выхо-
де схемы. Для этого откройте окно просмотра элементов, щёлкнув мышкой по кнопке Ele-
ments внизу левого окна. Раскройте группу Microstrip и щёлкните мышкой по подгруппе 
Lines. Нажмите клавишу Ctrl, установите курсор на входной порт, нажмите левую кнопку 
мышки и переместите порт на свободное место в окне схемы, разорвав его связь со схемой. 
Аналогично переместите выходной порт. Перетащите элемент MLIN в окно схемы и под-
ключите его ко входу схемы. Дважды щёлкните мышкой по элементу MLIN. В открывшемся 
окне свойств элемента введите W=0.45 и L=3, нажмите OK. Щёлкните левой кнопкой мыш-
ки по значку Copy и затем по значку Paste на панели инструментов (элемент MLIN должен 
быть выделен). Подключите скопированный элемент к выходу схемы. 

Установите курсор на входной порт, нажмите левую кнопку мышки и подключите 
порт ко входу схемы. Аналогично подключите выходной порт к выходу схемы. Схема долж-
на иметь вид, показанный на рис. 5.6. 

Откройте окно просмотра проекта, щёлкнув мышкой по кнопке Project в нижней час-
ти левого окна. 

Установите частоты проекта. Для этого дважды щёлкните мышкой по Project Options 
в окне просмотра проекта. В открывшемся окне опций на вкладке Frequencies в поле 

Start(GHz) введите 0, в поле Stop(GHz) 
введите 10, в поле Step(GHz) введите 0.5, 
отметьте Replace, нажмите Apply и OK. 

Щёлкните правой кнопкой мышки 
по имени схемы FilZ в окне просмотра 
проекта и выберите Options. На вкладке 
Frequencies отметьте Use project defaults и 
нажмите OK. 

Щёлкните правой кнопкой мышки 
по имени измеряемой величины 
FilZ:DB(|S(2,1)|) и выберите Properties. В 
открывшемся окне в поле Data Source 
Name введите All Sources, нажмите OK. 

Откройте окно графика и щёлкните 
мышкой по значку Analyze на панели ин-
струментов. Рассчитанный график показан 
на рис. 5.7. 

Рис. 5.6

Рис. 5.7 
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Отредактируйте параметры графика. Щёлкните правой кнопкой мышки по получен-
ному графику и выберите Properties. На вкладке Axes для оси x снимите “галочку” в Auto 
divs и в поле Step введите 0.5. Для оси Left 1 снимите “галочки” в Auto limits и в Auto divs, 
в поле Min введите -70, в поле Max введите 0 и в поле Step введите 5, нажмите Apply и OK. 

Отредактированный график показан на рис. 5.8 
Щёлкните по значку Tune Tool на панели инструментов, 

чтобы настроить схему. Двигая движки на блоке настройки, добей-
тесь требуемой характеристики (рис. 5.9). Переменные получили 
значения, после округления до пяти сотых, показанные на рис. 5.10. 

 
Сделайте активным окно схемы и щёлкните мышкой по значку New Schematic Layout 

View на панели инструментов, чтобы создать топологию схемы. Выберите в меню 
Edit>Select All, чтобы выделить топологию. Щёлкните по значку Snap Together на панели 
инструментов, чтобы упорядочить топологию. В поле Grid Spacing на панели инструментов 
введите 0.5х, чтобы размер ячеек сетки был равен 0.05 мм. 

Щёлкните по 
значку View Area на па-
нели инструментов и вы-
делите входной провод-
ник так, чтобы была вид-
на сетка. Убедитесь, что 
проводник совпадает с 
сеткой. В нашем случае 

это не выполняется (рис.5.11) и требуется отредактировать положение топологии, сдвинув её 
влево на 0.1 мм, иначе порты в электромагнитной структуре не установятся. 

Выделите всю топологию, установите курсор на любой проводник, нажмите левую 
кнопку мышки и нажмите клавишу Tab. В открывшемся окне ввода координат в поле dx вве-
дите -0.01, в поле dy введите 0, нажмите OK. Созданная топология показана на рис. 5.12. 

Рис. 5.9 Рис. 5.8

Рис. 5.10 

Рис. 5.11 

Рис. 5.12 



Создайте электромагнитную структуру. 
1. Щёлкните по значку New EM Structure на панели инструментов. В открывшемся окне 
в поле Enter a name for the EM Structure введите имя структуры FZ, отметьте AWR 
EMSight Simulator и нажмите Create. 

2. Щёлкните по значку Substrate Information на панели инструментов. Откроется окно 
свойств электромагнитной структуры. 

3. На вкладке Enclosure в поле X_Dim введите 24.85, в поле Y_Dim введите 9, в поля 
Grid_X и Grid_Y введите 0.5. 

4. На вкладке Material Defs в области Dielectric Definitions введите Er=10.4, 
TanD=0.0001. 

5. На вкладке Dielectric Layers в столбце Thickness для слоя 1 введите 6, для слоя 2 вве-
дите 0.5. 

6. Нажмите OK. 
7. Сделайте активным окно топологии схемы, выделите всю топологию и щёлкните по 
значку Copy на панели инструментов. 

8. Сделайте активным окно электромагнитной структуры и щёлкните по значку Paste на 
панели инструментов. Вставьте скопированную топологию в корпус электромагнитной 
структуры так, чтобы левый и правый края топологии точно совпадали с краями корпу-
са. 

9. Установите курсор левее и выше электромагнитной структуры, нажмите левую кноп-
ку мышки и, не отпуская кнопки, переместите курсор правее и ниже электромагнитной 
структуры, чтобы выделить всю топологию. Щёлкните по любому проводнику правой 
кнопкой мышки и выберите Shape Properties. В открывшемся окне в поле Material 
введите 1/2oz Cu и нажмите OK. 

10. Щёлкните мышкой по входному проводнику, чтобы выделить его. Щёлкните по знач-
ку Edge Port на панели инструментов, поместите курсор на левый край входного про-
водника так, чтобы на нём образовался небольшой прямоугольник, и щёлкните левой 
кнопкой мышки. Щёлкните мышкой по прямоугольнику порта, установите курсор на 
правую сторону порта так, чтобы курсор отображался в виде двойной стрелки, нажмите 
левую кнопку мышки и сдвиньте референсную плоскость порта вправо на 1 мм. Анало-
гично установите порт на выходе фильтра. Электромагнитная структура должна выгля-
деть, как показано на рис. 5.13. 

11. Откройте окно схемы и 
щёлкните по значку Ana-
lyze на панели инструмен-
тов. Рассчитанный график 
показан на рис. 5.14. 

 
 
 

Рис. 5.13  
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Рис. 5.14 
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